,, POLICY
>~

@3
TOKEN NUMBER
77350

SCANTHE QRCODEFOR |
DIGITAL SUPPORT /

W

Ry




i S

o et s g B =

1

For Learners of Digital Generation

by
Abhinav Bhatnagar
B.Tech




il Industrial Arcd. ‘
[;;:“-1‘2 ‘Il;iillil::d Garden Metro Station
Delhi-110093 (INDIA) _
info@brillianttmoks.co.-m
www.brilliantbooks.co.imn
Tollfree : 1800 270 1317

Editor
Pragati Jain

© Publishers

Published & Pnnted by :
Vidya Prakashan Mandir (P) Ltd.

" | ¢ Allrights reserved. No part of this book may be reproduced in any form without

= written permission of the publishers.

- | o The author, the editor, the publisher and printer have made their best endeavour to
provide authentic, accurate, impeccable and up-to-date information in this book.

Hquver. they do not undertake any legal responsibility for any misinterpretation or

error inadvertently crept in. Creative suggestions for the improvement of the book

are solicited for as they would serve as feedback and would be incorporated in the
ensuing editions. '




& 9
- { <

&  +Preface

e s -

Computer Science in the school curriculum deals with computers and their applications.
Today, irrespective of geographical, economic and social parameters, computers have
become an integral part of our lives. The fast pace of advancing technology coupled with the
numerous fields in which computers are used makes it essential for children to become
familiar with computers and their applications. It is imperative that the basic knowledge of
computers is imparted to children as early as possible. This will give them enough scope to
explore and experiment with a myriad of applications.

Computer Concepts— For Learners of Digital Generation, a series for grades 1t0 8, is a

diligent effort to provide the best and comprehensive understanding of the subject. Simple
language, real-life connections to explain abstract concepts, activities, information and facts
make the entire learning experience lively and fun.

This series focuses on— Windows 7, MS Office 2007, MSW Logo, Tux Paint,
QBASIC, Flash CS3, HTML, Visual Basic 2008 and Internet.

Salient Features of the Series :

®  Lesson Extract outlines the objectives of the chapter. .

®  Chapter Content starts with an engaging introduction. The text is supported with
pictures and relevant screenshots.

® For your Info (Information) gives extra and useful information for memory
reinforcement. :

®  Time to Drill interspersed within each chapter to check the alertness of the students.

®  Lab Visit provides more activities that can be done in the [ab.

®  Test Papers provide sample questions to assess students’ understanding of

the concepts learnt.
A series that will prove to be a treasure house for overall digital development.

We expect that Computer Concepts will help students make computers their Digital Buddy
and useful in all real-life situations. We look forward to your response to the series and to any
suggestions you may have to improve the same.

—The Publishers
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{

A computer is an electronic device which accepts the data from the user, processes it and
gives the desired output. It is a machine capable of performing calculations with the help of
mechanical computing devices. It is a collection of hardware and software components that
help us to accomplish many different tasks.

BASIC OPERATIONS OF A COMPUTER

A computer basically performs five major operations or functions :
1. TItaccepts data or instructions by way of inputs.

It stores data.

It can process data required by the users.

It gives result as an output.

It controls all operations inside the computer.
APPLICATIONS OF A COMPUTER

Computers are used for the following purposes:

They are used at homes for playing games, listening to music, storing addresses and
telephone numbers and many other things.

They are used in schools for preparing lessons, teaching different subjects, preparing
projects, etc.

PIIF I

'_I'hey are used in offices for maintaining office records, communicating important
information through e-mails, calculating data, etc.

They are used for creating animation films and advertisements.

They are used in banks, hospitals, space centres, airlines, railway reservation oftices and
many different places for commercial purposes.

COMPUTER DESIGN

A computer has two main parts :
1. Hardware

2. Software

l cpmnnlar Sclence é
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| » Central Processing Uni

Arithmetic
Logic Unit

and accepts instructions Of data given t0 the computer. In the memoy
d data are stored. All the intermediate and final I'f?SllltS are also storgg
etic logic unit (ALU) is the place vyhere arlthmgtlc and logicy)
operations are performed. The control unit reads the instructions stored in the memory,
interprets and executes them.When arithmetic and logical operations are to be peTfOI‘mEd,
they are done using the arithmetic unit. When the results need to be printed, the control unjt
activates the output unit and the results get printed.

The control unit, memory and the ALU put together are ca

(CPU) of the computer.

input Units
Input devices accept data from a user and convert them into a form that can be understood by
devices include Keyboard, Mouse, Joystick, Scanner, ¢

the computer. Some common input
You have already studied about these input devices in your previous classes. Let’s kno¥

about some more input devices.

Barcode Reader
A barcode reader or barcode scanner is an electronic device for reading

printed barcodes. A barcode is a printed horizontal stri i

. - - . S

which are used for identifying specific items. It consistspog :. ‘lfiegrliic:é iy
urce,

a lens and a light sensor.
Optical Mark Reader (OMR)

Optical mark reader is an input devic
e used : :
forms such as surveys and tests. for capturing human-marked data in documf’“t
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The use of OMR is not limited to schools or data

collection agencies; many businesses and health
care agencies use OMR to streamline their data
input processes and reduce input error.

Optical Character Reader (OCR)
Optical character reader, usually called OCR, is used

to do mechanical or electronic translation of ’? For Your Iu@o
i

handwritten, typewritten or printed text into

A JEe i 2
machine-encoded text. It is widely used to convert Dc mansldaryessancivasen Tof

books and documents into electronic files. It is also
used to computerize a record-keeping system in an

» pattern recognition, artificial
I intelligence and computer vision.
_____________________________________ _\

office, or to publish the text on a Website. OCR software now has been attached in a scanner

and mobile phone also.
Magnetic Ink Character Reader (MICR)

Magnetic ink character reader is an input device used
for character recognition technology by the banking
industry to facilitate the processing of cheques and
debit/credit cards. The technology allows computers to
read information (such as account numbers) from
printed documents. Unlike barcodes or similar
technologies, MICR codes can be easily read by
humans.

Output Units

Output units convey information from the computer
to the user. The various output units are: Monitor,
LCD Projector, Printer and Plotter.

Monitor

It is used to display images that a computer
program generates. Like a television, it also has a
cathode-ray tube (CRT) to display images on the
screen. Now, monitors are available with flat-
panel wusing liquid-crystal-display (LCD) to
produce images.

LCD Projector

LCD projector is a type of video projector for
displaying video images or computer data on a
screen. It is commonly used in organizations for
displaying PowerPoint presentations  during
meetings.

il
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Printer hics of
d/or grap

In computing, a printer p,pducc.s L usually on I
documents in an clectronic form, marily used a5 loca
transparencies. Many printers are prim rinter cable.
peripherals, attached to the computer by ap

Plotter ]
- : intin
A plotter is a computer printing device for pr mhigﬁ m}ﬂa |
vector graphics. Plotter is used for creatmbgl s of A At
quality graphics, visuals, charts, graphs, ta AR EREEEES

diagrams.

¢ Fo Voo Tnfo

B The world’s first computer printer was a 19tg
= century mechanically driven apparatus n:wente
i by Charles Babbage for his Difference Engine. 5

fUpEap————— L etk

Central Processing Unit (CPU) ) .

The central processing unit (CPU) 15 the primary clement that can,
out each instruction of the program 11 sequence, to Pel‘for_rn the has'&
operations of the system. In other words, it perfqrms the arithmeg, 2
logical calculations of the data. The CPU 1s capab}e of sty
enormous amount of data and processing them at a high speeq i
producing useful results. The CPU is inside the CPU-box. "

The three main components of a CPU are :
1. Arithmetic Logic Unit (ALU) : It performs arithmetic and logi;

operations.
2. Control Unit (CU) : It extracts instructions from memory, decod:

and executes them.

3. Memory Unit (MU) : The coimputer has a large 2 For Your Ingo
storage capacity. The storage capacity of the ’ —
computer is called its memory. Memory enables * [l ROM is non-volatile while RAM
the computer to store data and instructions, volatile, that is, the informati

T
There are two types of computer memory : ,' stored in RAM is designed to clex
Primary Memory | When the computerisnot on.

""'"'-—-—-—-—.___._ —————

by the CPU for reading and storing, There are tw
0

types of primary memory : RQOM
Memory) and RAM (Random Acceg, Megf;‘; Only

.
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Secondary Memory
It is.also known as auxiliary memory. It is used for storing data or programs on a temporary
or on-a permanent basis. The secondary memory is available in the form of storage devices.
For example, hard disk, compact disc, flash drive, ctc.

The CPU cannot access secondary memory directly while processing inf_om_lation. The data
is transferred to the primary memory when required. The computer used its input and output
devices to access data stored in the secondary memory.

2. SOFTWARE

Software relates to a set of programs. The software controls the computer hardware parts and
makes them operational. In other words, it governs the operations of a computer system.
Categorization of Software : Software is classified into two broad categories :

® System Software

® Application Software

System Software

System software performs the basic functions that are necessary to operate a computer
system. It controls the various resources of a computer system. The operating system is an
example of system software.

Windows 7 MAC OS Linux

System software are of three types :
® System control software

® System support software

® System development software
Application Software

Appl.ication software consists of programs that are designed to do routinely performed
specific tasks, such as payroll, inventory, word processing, graphics, spreadsheets, desktop
publishing, etc.

‘ Gomputer Science
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MS PowerPoint MS Word

There are two types of application software :

® General purpose software
® Application dedicated software

Software
! |
System Software Application Software
! ' . ' 1
System control System support System General Application -
software software development purpose dedicated
software software software
I i I }
Utility Language Database Performance
programs translation management statistics
system software

® Collect pictures of interfaces of different software which falls into different categories. Make
a poster using these pictures.

RELATIONSHIP BETWEEN HARDWARE AND SOFTWARE V

The hardware and software together make a |
computer system. Both are essential components of |
a computer system. Hardware is the physical |
i component of a computer system, and the software |
are the instructions or commands that make the |
hardware components operational. The software is |
the driving force of a computer. '

gy 1A
YL Ie o

STl oftWare ;

Hardware

Hardware - Software Relationship

Y
-
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DATA HIERARCHY:
You know that data refer to raw facts and figures, and consist of alphabet, numbers, sounds,
pictures, images, etc. | |

A computer system processes data and gives information that is used for various purposes.
The data is stored in the form of bits and bytes in a computer database.

Bit
Bit l
A bit is the short form of Binary Digit. A computer system
represents data using the digits 0 and 1. These digits show whether Byte
the computer circuits are ON or OFF. A bit is therefore represented !
by an electronic circuit that is either ON or OFF. Fiald
Byte l
A byte is the collection of 8 bits. A byte of information is stored by Record
using several bits in a predefined combination called Bit patterns.
Two such bit patterns are ASCII and EBCDIC. l

W The full form of ASCIl is American Standard Code for Information b
Interchange and that of EBCDIC is Extended Binary Coded Decimal Database
Interchange Code. Abyte represents a character such as A, B, 1, 2, etc. The ascending order

of data hierarachy

A%? For Your Iﬂ-& FIe

A field is a collection of bytes that contains data about an item. For example, the name of a
student, his/her age, his/her class, etc.

Record

A record is a collection of interrelated fields. For example, a student’s record may contain
fields such as name, age, class, subjects, etc.

Files

A file is a collection of related records. For example, a collection of all records of all the
students in your class is class file.

Database

A database is a collection of all the files in an organization. For example, files of students,
teachers and other staff members of your school make the school database.

TYPE OF COMPUTERS

On the basis of their size and speed, computers are generally classified as follows

1. Microcomputer 2. Minicomputer
3. Mainframe computer 4. Supercomputer
Microcomputer

Microcomputer was earliet: a commonly used term for personal computers. A personal
computer -assemblage consists of CPU, computer memory (primary and secondary) and
various mput and output devices. Only one person can use it at a time. It is slow and has

‘ ~ Computef Scisnce:
E Bodk-8'




ared to @ minicomputer oF a mainframe -
( ks, universities, etc.

acity as comp
available nowadays.

relatively less storage cap
1¢8, ban

is commonly used in classrooms, hon
There are various kinds of microcomputers

ned to fit comfortably on top of a desk, typically |
i ‘I‘i:'.

t on the side. .
4 can keep it on youl lap. Nowaday |

o >y,
hscreen environment thy may

re available in 5 Vari
y,

here.
Desktop : It is a microcomputer desig

the monitor in front and the system uni

Laptop : It is a portable microcomputer. YO

computers are more commonly called notebook compu

Tablet : It is a mobile computer. It offers the users a touc';r e

may not be accompanied by a stylus (a pointing device)-

sizes and have a built-in/virtual keyboard. .
a mobi

It is a mobile phone built on e
: hone like compact digital cameras,

le OS. It has enhanced featy,
GPS, Web_bro“?;{a

Smartphone :
compared to an ordinary mobile p

Desktop Laptop

A minicomputer is much larger than microcomputer
and also much more expensive. It thus lies between
microcomputers and mainframe computers and are
often referred to as midrange computers. It possesses
most of the features found on a mainframe computer,
but on a limited scale. It can still have many terminals,
but not as many as the mainframe. It can store a large
amount of information, but again usually not as much
as the mainframe. It uses an enhanced instruction set _
to facilitate scientific processing and commercial

applications. Medium and small businesses and
Minicomputer

colleges typically use ;:ucomputers.
can

g T
M

Mainframe computers are very large, often filling an entire room. They

enormous amount of information, and perform many tasks simultaneousl
communicate with many users at the same time and are very expensive.
computers usually have several terminals connected to them. These terminals look |
computers but they are only devices that are used for sending and receiving in
from the actual computer using wires. Terminals can be located either in the $2

"
g 12
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with the mainframe computer, or they can also be in g )
different rooms, buildings, cities, etc. Large businesses, ... 4

_

government agencies, banks and universities usually use
mainframe computers. Big hospitals, airline reservation
companies, and many other big companies prefer
mainframe computers because of their capability of
retrieving enormous data.

-
erl
of

Supercomputer i1s one of the many types of modem i,
computing machines which are big, powerful and are Mainframe computers
capable of doing very speedy calculations. It is because
of their high speed processing ability that supercomputer
systems are used in animation graphics, weather
forecasting, nuclear research work, petroleum research
works, crypt analysis, molecular modelling and the likes.
The difference between the mainframes and
supercomputers is that while mainframe machines are
primarily used for a number of purposes, supercomputers -
are designed to serve a singular purpose.

[P
)
W
)

Y I @3Joost Bfour Uetrain
A. Tick (v') the right option.
1. s is a device used for creating high quality graphics.
(a) Plotter ., (b)Printer
(c) MICR L, (d)OMR

2. Barcode reader is a device used for
(a) reading barcode
(c) storing data

3. OCRis used for

. (b) reading magnetic code
. (d) none of these

(a) entering text into the computer [ (b) reading the optical signals
() reading the magnetic character L (d) all of these
4. Information on cheque is sorted using
(a) MICR ., (b)OCR (_; (c)OMR . (@LCD
5. Primary memory is also called
(a) internal memory

__ (b)external memory
(c) storage memory

(__ (d) none of these

‘ Computer Science
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. hed in
6. OCR software is also been attac mobile phone

' b
(a) scanner - Edi s e §
(c) both of these Ll L
B. Fill in the blanks with the correct word. . SR T
secondary memory Random Access program
) SRP— memory is non-volatile.
.............. memory is volatile.
; ;(;:.;ndary memor;};fthe computer is also called the ... memory.
4. The storage device of a computer system is referred to ... .
5. Software relates to a set of ........cccovveeereens » '
C. Classify the following as an input, output or a storage device.
1. Light Pen 2. Optical Mark Reader 3. MICR
4, Plotters 5. Flash Drive 6. Monitor
7. Scanner 8. Speaker 9. Microphone
10. Printer 11. Compact Disc 12. Barcode Reader
D. Write the full forms of the following abbreviations.
1. MICR 2. OCR 3. RAM 4. ALU
5. ROM 6. CRD 7. LCD
E. State whether the following statements are true or false.,
A computer has two main parts : hardware and software. D

Data are entered into a computer using output device.

CPU is the brain of the computer, - E

2

3

4. Secondary memory is used to store data for long term use.
5. Data are stored in a computer in the form of words and letters. ﬁr |

E. Answer the following questions.
1. Explain the term computer memory.

2. Which device is used for reading barcode?
3. What is MICR and where is it used?
4. Whatis an Optical Mark Reader used for?

--------------------------------------
---------------------------------------------------------------
-------------------------------------
.......................................

5. Explain the two types of memory available in computers.

14
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6. Write short note on the following :
(a) Hardware & Softwar .
e b A : .
(c) Data Hierarchy. (b) Application soltware & System softivare,

«  Solve the following crossword with the help of hints given below :
1. A monitor with flat panel (3)
5. A part qf CPU that performs arithmetic and logical
operations (3)
6. Used in banking industry (4)
7. Used to convert printed text into machine-encoded

text (3)
8. Storage capacity of the computer (6)

10. A volatile memory (3)
DOWN{ !
2. Performst

3, Ascanner to read vertical bars (7)
e used for reading marked data (3)

he basic operations of the computer (3) 5
R

4. An input devic
9. A non-volatile memory (3)

e a list of hardware being used there.
e installed on the computers.

ine or brochure with pictures of computers
uld wish to include in your

par
ke a list of softwar

tem. Find a magaz
pictures of items that you WO

ictures on a sheet of paper.

1. Visit your computer lab and pre
2. Visit your computer lab and ma
3. Design your own computer sys
and related accessories. Cut out
computer system and paste the p

A -

hort presentation on th
ctures an

e various input, output and storage
d genuine facts can be taken

) On Teacher's Desk

students to make a s
i market these days. Relevant pi
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. Lesson Extract - iy
Operating Sysiem - Operating System Interface
=unctions of an Operating Sysiem -~ Popular Opetng Syctems
« Importance of Shut Down

am in a computer system. It
of the

You know that an operating system is the most important program
is an integrated set of system software used to manage the different resources

computer system and its overall operations.

T kel =2 ¥
= ~ 1

. o w | e L0 0

[t assists the computer system to run various
application programs. It contains instructions to carry
out different tasks in the computer system. It is an
organized collection of programs in the computer
system that provides the necessary environment for

the execution of different application programs.

e e eRwTay

Windows 7

MACOS

{16 |

Computer 3cience

Book-6




' Whenever you start any application software,
- when you open any file then a copy of that file is
| This is done by an operating system. It allocates certain m

In early days computers, there were no operating systems. But all the modern day computers
have one or more operating systems. Operating systems are loaded first in the computer
system. When you switch on the computer system, the operating system loads automatically.

This is called booting.

FUNCTIONS OF AN OPERATING SYSTEM

An operating system is responsible for carrying out a number of functions to enable the user
and the software to interact with the hardware. Different functions are essential to operate
the computer system efficiently.

Some key functions performed by an operating system are as follows :

® Process Management ® Device Management

® Memory Management ® File Management

Process Management
An operating system controls and schedules the processes for execution by the CPU. It is
responsible for allocating the CPU’s time to each process. You may think of the process as
an application, but that does not give the complete picture of how processes relate to the
operating system and hardware. An application in MS Office, is indeed a process. However,
it may cause several other background processes to begin, such as, virus checks, memory
management, etc. _

After a job is done or a process is completed, the CPU becomes idle. After that if there are
other processes in queue, then the time is allocated to each process of the CPU. This whole

system is managed to ensure maximum output from the system.

Processll ——— Process| ——— CPU

CPU Process Queue

Device Management

Devicg management 1S an important function of an _ 5 1. Your Inﬁo

operating system. It co-ordinates and controls the |

various input and output devices attached to the ‘ _

system. When the system is ready to take input then ¢ software called device driver, to
recognise the input and the output

the input device is made available to the user and ! o s o HacH OGO
when the processing job is over then the output is I______________d_______________p_____',___ §

redirected to the output device.
Memory Management

An operating system needs a

it gets loaded onto the system memory and

loaded onto the memory from the disk.
emory area to itself with the help

. of the booting process and sets aside the remaining area for various application programs.

| sectors. At the time of storing data on the disk, it is not compu

File Management

A lot of data is stored on the hard disk which in turn is formed of millions of tracks and

Isory that it occupies the

(17]
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tem to read the file from differ“—m

sectors in a sequence. It is the job of an operating system
(racks and sectors when required, and also store it in the available space. Thus, an operatj;, -
and writing of the file system. It also operates the user g D

IB

P

system manages the rcading
application [ilc access authorisations.
ensure smooth operation of th

back up, etc. i

5: .

Housekeeping
Housckeeping includes all the services necessary to

computer system, like sccurity, protection, resource accounting,
ek
a0
so that only one user cap
rating system most people

he Mac QS are a few

TYPES OF OPERATING SYSTEM

Single-user Operating System
As the name implics, single-user operating system is designed

effectively work on a computer at a time. This is the type of ope
use on their desktops and laptops today. Windows 98, DOS and t
examples of a single-user operating system.
Multi-user Operating System

multiple users at the same time and/or different

A multi-user operating system supports
times. The operating system must make sure that the requirements of the different users are
has sufficient and separate resources

balanced, and that each of the programs they are using
so that a problem with one user does not affect the entire community of users. For example,
d thousands of networked

UNIX, Windows NT and Novell Netware, can support hundreds an

users.
OPERATING SYSTEM INTERFACE
ing system provides a platform on which the application program runs. It pr

The operat
an interface which can be further classified.

Character User Interface (CUI) :
In CUL the operating system provides an environment where the user needs to type s
command to perform a particular action. For example, Disk Operating System (DOS). -
Graphical User interface (GUI)

In GUI, the operating system provides a graphical environment where the mouse acts as?
pointing device. The user can perform an action just by a mouse-click. For exampl,
Windows operating system. -

POPULAR OPERATING SYSTEMS
There are many operating systems available nowadays. Some of these are :

ovides

® DOS

® MS Windows \
® UNIX

® LINUX

® MACOS
Let us discuss important features of some popular operating systems.

| gy
18 |»
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DOS stands for Disk Operating System. It is a single-user o
IBM or IBM compatible computers in the carly 1980s. It com
PC DOS.

perating system developed for
¢s in two forms : MS DOS and

-

[ PP —,

DOS was {f_ery popular and widely used in microcomputers. It however, uses a command
line interface or character based interface. So after the invention of graphical user interface

operating systems, its use declined. It is a single-user operating system, i.e. it can support 5
only one user and one program at a time.

Windows

The Windows operating system was developed by Microsoft.
It uses a graphical user interface and is hence easier to use. It
allows users to interact with the computer system using
graphic images and screens.

Windows has many versions. Some of these are - Windows
3.0, Windows 3.11, Windows 95, Windows 98, Windows Me,
Windows XP, Windows NT, Windows 2000, Windows 7,
Windows 8, Windows 10.

Unix

Unix is a multipurpose operating system. It is used in m
microcomputers Minicomputers and Mainframe computers. It is a multi-user, multi-tasking

operating system. It uses a command line interface. It is very powerful operating system with
secure and stable configuration. D R

Linux

ost types of computers. It is used in

It is a Unix based operating system that uses Graphical User
Interface (GUI). It is an open source program and available
free of cost. It comes in many versions. It is also very secure
and stable operating system. Nowadays it is gaining
popularity among its users due to its numerours cost

Computer Science
_raldl N~ PR




effective features. Many companies offer Linux with a diﬁ‘cr_enl look and feamres. Some .
the popular Linux flavours are Mandrake Linux. SUSE Linux. Red Hat Linux. Cal
Linux, Turbo Linux, etc.

Mac 0§

The Mac operating system was designed and } C1 005 Aiceesatt arparatlon 1 Lyl s
developed by Apple Corporation for its Macintosh Saate
computers in 1984, Tt uses Graphical User Interface.
It is one of the most advanced operating systems.
but it can be used only in computers developed by
Apple Company. It supports  multi-use, multi-
tasking features. It is a very secure and stable
operating svstem. It has a very attractive look. It has
Some  extremely advanced features like speech
recognition and enhanced multimedia capabilities.

Choosing an Operating System

Operating systems are must for computers nowadays. People purchase the operating system
with the computer system. All operating systems are, however, not suitable for EVeryone.
There are many operating systems that are developed for specific purpose and they work
effectively in their environment only.

The choice of an operating system depends on the use of the
use a single user operating system like DOS for multi-user
computers use different types of operating systems. Yo
designed for microcomputers in a mainframe or supe
purchased according to the types of computer and its use.

IMPORTANCE OF SHUT DOWN

By now you are well aware that Windows remains in the
on. After completing the work, these operating system
properly so that no damage is caused to these files, Thi
an operating system.

If you switch off the computer without
giving a proper shut down command then
there are very high chances of losing the
data and it may also damage the Windows
operating system.

Follow these steps to shut down a
computer properly :

{f
d&r. ®

computer system. You cannot
purpose. Also, different types of
U Cannot use an operating system
recomputer. Operating systems are

computer memory till the power is
files are sent back to the hard disk
§ process is known as shut down of

Switch user

Log off
1.~ Click on Start — Shut down option. o
. . Restant
2. For other options, click on the arrow
right to Shut down option. it Slm_’
generally  shows the following shiit down options
options.

T Using Start meny .tlo .s-hult‘ down
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Switeh user : It switches the user without closing the programs currently in use.

Log off : It closcs all programs running on the computer, however the computer still
runs.

Lock : It locks the computer and the work on programs running can be resumed on
unlocking the computer.

Restart : If duc to some crror the computer needs to be shut down, then it can be
restarted by uqmg the Restart option. This option shuts down the Windows properly and
then starts it again immediately.

Sleep : It puts the computer in a low-power state and saves the work being done so that

it can be resumed from the point where it was left off.

A.

Tick (v ] the rlght option.

1. An operating system is a .....oeueen. software.
(a) Application L_| (b)System 1:____1
(¢) Utility L1 (d) None of these fat
2. When you switch on the computer system, the operating system loads automatically.
Thisisealled ..o
(a) Booting [ 1 (b) Shutting down [
(c) Operating [ 1 (d)Processing ]j
R0 LT E—— :
(a) Command Line Interface D (b) Character User Interface L
(c) Graphical user Interface L_| (d) None of these !
4. Linuxis a........... based operating system
() Unix L1 (b) Windows 5
(<) DOS [ 1 (d) None of these =]

Fill in the blanks with the correct word.

‘manager Disk Operating System the human System hardware interface Single-user

1. An operating system is a ..........coeesuunnen. SOftware.

2. AN .. SYStEM IS AN vceerrrenssssies. DEEWEEN oo, USET and computer

3. DOS stands for ...

4. - operating system is selected when one user needs to do one thing at a
time.

5. An operating system works as a .......ocveeens «

' l:emlunur Snlnm:a
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ments are trué or false.

; ing state L. .
state whether the following's for the functioning ofa COI?IPUE?F

C. -
o system is not responsible 25 . ’.
1. Anoperating systemi1s not resj ek ey i
2. Various programs run in the computer sys :
ing state is called a file.

3. The program inarunn
There is only one type of operating system.

soft.

4, .
icro

5. The Windows operating system was developed by M

6. Mac 0S was developed by IBM.

D. Give difference between :

1. CUland GUL
2. Single-user operating system and Multi-user operating system.

3. File Management and Memory Management.
E. Answer the following question.
it ?
1. Whatis an operating system? What are the uses of an operating system:

Ll ail bl bl Lt bt L L T HesprarsaatuERTTREnE e L L T L L L L L T
TR T TP T T} we
Likascntubib b b L R b BraNERATNEERE RS RT R BN AR

b

......
...........................................................................................................................................................................

3. Explain the two operating system interface.
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6. Write short notes on the following operating system :

~ (a)DOS (b) Windows  (c) UNIX (d) LINUX (e) Mac 0S

—

ik Coll:ect the names of as many operating systems with their versions as possible. Make a chart
stating the names of these operating system with their types.

1. The Disk Operating System (DOS) su i
pports CUL. Find out some more detail
can take the help of your teacher or the Internet. A

2. Visit some places where different t i . '
ypes of operating systems are us i i
uses of the Operating systems in these places. T o e

= .
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Linux is a Unix-like computer operating system designed by Linus Torvalds. It was released
on 5 October, 1991, when Torvalds was still a student at the University of Helsinki, Finland.
‘Linux is free and an open source operating system software, that is it is free to use, modify
and distribute both commercially and non-commercially. Anyone with licenses such as the
GNU General Public License can modify and improve the program as per their own
requirement. They can even release their improved version to the public. Because of this,
Linux has grown from a small number of C files in 1991 to over 370 megabytes of source
code in 2009. All this is because, in Linux, you have free access to the source code.

Linux is also multitasking, multi-user operating system which means that many people can
run many different applications on one computer at the same time. This differs from MS-
DOS, where only one person can use the system at a particular time. When many people are
working, then each user is identified by the system through their unique Login ID, and
Password.

Debian, Red Hat Enterprise Linux, Mandriva, open SUSE and Arch Linux are popular Linux
distributions. More than 90% of world’s 500 fastest supercomputers including top 10 fastest
supercomputers run on some variant of Linux. Some key features of Linux are :

Multi-user Operating System

Linux supports multiple users at one time. In these types of OS, there is a server and all the
users are provided different terminals.

Free and Open Source

It means it is a free software which can easily be downloaded from the Internet and anybody
can use and modify it as per their requirement.

Multitasking

Linux operating system can run on many different computer platforms.
Security

Linux is one of the most secure operating systems. File access permission systems prevent
access by unwanted visitors or viruses. Every user needs their own user 1D and password.
Portable

A Linux kemnel and application program can be installed on any kind of hardware platform.
Hierarchical File System
Linux provides a standard file structure in which files are arranged.
Shell
Linux provides a special interpreter program which is used to execute commands of the
operating system.

P g8y @ |
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COMPONENTS OF LINUX the fi
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Linux system is divided into following major components/layers (see the figure below): -

Kernel gt +—— User,

Hardware

1. Hardware : It consists of all peripheral devices like RAM, CPU, etc.

2. Kernel : Kernel is the main part of the operating system. It performs the task of creating
and maintaining the Linux environment. It acis as an interface between the hardwar
and the shell. It also controls the hardware, CPU, memory, hard disk, network card, efc
attached to the computer.

3. Shell : It is a program that acts as a command interpreter which is an interface betwee!
the user and the operating system. It interprets the commands entered by the user ai
passes them to the kernel. There are number of different Shells available like Bour™

shell (sh), Kornshell (ksh), C Shell (csh). Each provides a slightly different interface
between the user and the Linux operating system.

4. Utilities and Application Programs : There are the programs like Word Processors

Spreadsheets, Database Management Systems, etc. that are supported by Lint
environment,

T |
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Linux system is divided into following major components/layers (see the figure bcl()w): g

Kernel G ” +—— Usery,

Hardware

Hardware : It consists of all peripheral devices like RAM, CPU, etc.

Kernel : Kernel is the main part of the operating system. It performs the task of creatin
and maintaining the Linux environment. It acis as an interface between the hardwar
and the shell. It also controls the hardware, CPU, memory, hard disk, network card, et
attached to the computer.

Shell : It is a program that acts as a command interpreter which is an interface betwee
the user and the operating system. It interprets the commands entered by the user an
passes them to the kemel. There are number of different Shells available like Bourt
shell (sh), Kornshell (ksh), C Shell (csh). Each provides a slightly different interface
between the user and the Linux operating system.

Utilities and Application Programs : There are the programs like Word Processor

Spreadsheets, Database Management Systems, etc. that are supported by Lint
environment,

124
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, ~ Lesson tract | ___......-‘

« Headers and Footers < Watermarks + Increase or Decrease Indentation
» Footnote and Endnote < Drop Cap « Borders and Shading

+ Symbols <« Tab Stop + Page Setup and Margins

+ Equations < Columns + Applying Built-in Styles

In the previous class, you have learnt about some of the features of MS Word 2007 and the z
different formatting tips. MS Word 2007 also provides certain additional features that make { }
your work easy and well-structured. You can add page numbers, headers and focters,
symbols, equations, watermarks, and can also look up a word in the Thesaurus fo {ind
similar words.

HEADERS AND FOOTERS

Header is placed at the top of a page of a document. The footer on the other hand, is placed
at the bottom of the page in the document. The Header and Footer usually contain the same
information such as page number, date, photograph, time, etc.
The various steps to set header and footer are :

v 7) For Your IHgO‘

® Click on Header or Footer option from the %

By default the header is printed 0.5
inches from the top of the page and
the footer is printed 0.5 inches from

the bottom of the page.
The Header/Footer Design tab will display =~ “-=-——mmomommmmmem o A

on the Ribbon.

®  Choose the information (date, time, page numbers, etc.) or type in the information that
you would like to have in the header or footer.

'Ihe Headf-:r and Footer toolbar contains buttons that can help you automatically enter
important information in your header and footer. On clicking the Page Number in the Header

& Footer group on Design tab, you will get a drop-down menu that contains Format Page
Number option.

Header & Footer group of the Insert tab. A
built-in style box appears on the screen.

® Choose a style of your choice.

It opens the Page Number Format dialogue box so that you can format your page number in
the header or footer.

You can also insert date, time, picture or a Clip Art on the header or footer of the page.

ey
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The various steps to insert a footnote or endnote in a
document are

et | -
»  Goto the References tab on the Ribbon, A Ctrl + Alt

(Ctrl + Alt + D
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o Click on Insert Footnote button of
Footnote group to type in the
footnotc. ;

You can also insert footnotes or endnotes .

by clicking on the arrow at the Footnotes |

group. A Footnote or Endnote box appears | |

b
mn

on the screen. Choose the desired options
to change Format style and click Insert to | |
apply the change. s ——

_.'. iy s tiiotine s Lenc)- s
SYMBOLS —

Symbols are signs or special characters that
can be inserted from the Symbol dialogue

onpinbels | sgecsl Characters

. . ' i (noemal teat) “ et Conrenty Gymbuds
box. Symbols can be inserted and formatted in | " lalelili m':h" o
a document just like the regular text. glalele] Dl epeol ][0 ___
. ‘ . wlulbluluin v o]« T2l L]e
You see many symbols in publications that are | 3|-[/[° FHL*;: Tz ]

not available in your keyboard. For example, | weoesmio.

elefy|o| -]~ a] <z mlululﬂlﬂlnlzl'?‘l’fulsl*

the symbol for multiplication is not available -} =\ e L
on the keyboard but can be selected from MS- | e | | swtatsor. | sty scuce o
Word’s Symbol dialogue box. — ) G

inserting Symbols
Symbols and special characters are punctuation marks, spacing, or typographical characters
that are not generally available on the standard keyboard.

The various steps to insert symbols and special characters are :

@ Put the cursor in the document where you want to insert the symbol.
@ Go to the Insert tab and select Symbol group.

@ Choose the appropriate symbol from the symbol group.

Tneent | Pagelayout.  References Mailings  Review W

S eEODEe 3 4 DY Ad4! e T

=]

Yage Tabie h-mg C p Shapes SmanAnt Chat  Hyperd \k[noknuku sMideterence  Meader Footer - Page Text  Quick WovdAn { ,,“m_ A Tauation Symbed
neak 3 Art . » * Numbet® By bPans® o b . T
Tabies \_) Elust ations Link Rm}c-l &vie\ ¥ Tt .

St — e ———————— ..--,.._,......_.‘_....._._m,,.ﬁ._...,_,_.._._\.._....._._ i .
:3: ; T™ 2 ® § R
+ N ™ o noQ
fon § &
A1 Mle Symtals

MS-Word 2007 also allows you to insert mathematical equations. The various steps to access
the mathematical equation tools are :

@ Place your cursor in the document where you want to insert the equation.

® Go to Symbol group on the Insert tab and select Equation button. A drop-down menu
appears.

o compiterscionce . e
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’ Expansion of a Sum

4

T
1S

e n(n=Dr?

A+ =1+—+

1! 2!

TU Insert New Equation
o

@ Select the appropriate equation structure or click Insert New Equation. The requirg

equation will be inserted in the document.

To edit the equation click on the Equation. The Design tab will appear on the Ribbon. M

the required changes in the equation.
g H9-0:-

Home - Insert

Docurment I - Microseft Word

Fage Layout  Reberences Maifings Review  View | Design
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Symbials

WATERMARKS

A watermark is a translucent image By H0n0 s
that appears behind the text in
document. The various steps to .

i

insert a watermark in a document || -

are.

®  Go to Page Background group |

on the Page Layout tab to select
watermark buww.. A drop-down
menu appears.

Choose the Watermark to be
included in the document or

Equation Toals

|
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click on the Custom Watermark e

to create your own watermark.
(ou can thus remove or

dllow the above steps and click on Remove

e
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DROP CAP '
Drop Cap is a feature provided by MS Word in which the first character of the par_ag:r-aph is
bigger, and dropped on the subscquent lines of the parggraph to mark the beginning of
paragraph (as used here). You can use this feature while writing stories.
Follow these steps to use Drop Cap feature &'

SRl Qi Bad AT
of MS Word 2007 : SOy @8R o 322 T 20H
e In the Word 2007 document, click on g = —————

the position where you want to add the v

Drop Cap feature.

2 = i 3 Seatme ot by WS Pirrd = wihath T S
e Click on Insert tab = Text group = S A i 775

¢ - N 1S sbrpapert bees of he patagrast 3ok The begreeng of
]--)rnp (Jdp drop d()‘ " ]]SL. paragragh (a1 uwed here] You ran wie e featse wihille ety Somes
@ Sclect the Dropped option from the

drop-down list. = S S
® Click on Drop Cap Options... from the 7’:";” S T X _,

drop-down list. The Drop Cap dialog — =] e —

Drop Cap drop-down list

—IR = -
box opens. i _— =
@ Sclect the desired font of the dropped letter from the Font: 2= Do oy
drop-down list in the Options section. Opthms
® Sclect the desired option from the Lines to drop: list. | = =
® Increase the distance between the text and the dropped letter | »==2= =
with the help of Distance from text : list. RN ?
e Click on OK. :I Lomxos] focmes ]
TAB STOP Drop Cap dialog box

Tab stop refers to a preset text position. The Tab Stop feature in MS Word enables the user to
change default distance covered by the Tab key for the preparation of a columnar data in MS
Word.

Press the Tab key to move the cursor half an inch forward in a MS Word document.
inserting Tab Stop

Tab Stop can be inserted at any position on the ruler within the margins. When a Tab Stop is
set, MS Word automatically removes the default Tab Stops to the left.

There are several types of Tabs that are available in MS Word 2007. A few are discussed
here.

Left Tab : With this kind of Tab Stop, text or numbers are left-aligned in the

column.

Right Tab : With this kind of Tab Stop, text or numbers are right-aligned in the
column.

Center Tab  [L] : With this kind of Tab Stop, text or numbers are center-aligned in the
column.

Decimal Tab [] : With this kind of Tab Stop, fractional figures are aligned in such a way
that all the decimal points are vertically aligned.

g o ﬂ



Deleting Tab Stop L

stops. Let us creg A
Select each tab and drag it towards the document to delt“;;e ;ar?eed 1:0 be followsd e a ligy,
friends to understand this concept. Create this list, a few step - !

These are : :

@ Select the Left Tab from the Tab Selector, placed on the left side ot tteruler.

® Click at the desired > e
position on the "7 e rmetms s FE e )
Horizontal Ruler to ) et AN EC Lo :lafww'_‘ffff f‘:rﬂtf?' : % n
define the location of ™ 7 B/ U-dex xa /-A- >-Z- 4y e
the Left Tab Type 7 T e —— T EERC
NAME. \ - ' T

® Now, select the Right Tab Selector
Tab from the Tab
Selector. | NAME CLASS ~ ROLLNUMBER  MARKS

®  Click at the desired | Prashant I & e
pHOSiinIl on the | Pradeep [ 50 87%

orizontal Ruler to | | I :
define the location of | ! e ! 67 =
the Right Tab. Bring ' | ’
the cursor to NAME g ———————
and press the Tab key, = ™i4: w=vm &
write CLASS. Inserting Tab Stop

®  Select the Center Tab from the Tab Selector.

®  Click at the desired position on the Horizontal Ruler to define the location of the
Center Tab. Bring the cursor to CLASS and press the Tab key, write ROLL
NUMBER.

®  Now, select the Decimal Tab from the Tab Selector.

@ Click at the desired position on the Horizontal Ruler to define the location of the
Decimal Tab. Bring the cursor to ROLL NUMBER and press the Tab key, write
MARKS.

®  Move to the new line and type the values for each column.

®  Move to the next column using Tab key.

®  Once the list is completed, delete Tab Stop.

COLUMNS

MS Word allows the user to display the data in the form of vertical columns in the same way
as it appears in a newspaper. Already created document can also be converted into columns.
How to Make Columns in MS Word 20077

L)
4

Select Page Layout tab => Page Setup group > Columns drop-down list and select the
column style of your choice.

For choosing more column styles select, More Columns... option. The Columns dialog

box opens.

30 |
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| Thesaurus option

|

' ' on helow shows increase indentation.
For exemple, the second bullet in the Tist given htl”.“ sho ¢ FO'[%
milkshake.

are the ingredients required for making chocolatc

® | glass milk
2 teaspoons chocolate powder
® 2 teaspoons sugar

& Blender

How to Decrease Indent b
S . . A nne
If you want to decrease the indent, which means pushing the text tab space towar,

left, then you need to follow these steps. _ '
Place the cursor over the place where you wish to decrease indentation.

Click the Home tab = Paragraph group = Decrease Indent option.

2D

.
[

Thesaurus
Microsoft Office has some features that help you to look up for meanings/synonyms (wg

with similar meaning) for a given word. One of these features is Thesaurus. The b
function of Thesaurus is to look up synonyms for a particular word. It is just lik:
dictionary. and can be used for replacing a word with one of its synonyms.

Follow these steps to use the Thesaurus in MS Word 2007 :

¥ Select the word for which you want an alternative word.

¢ Click on the Review tab = Proofing group = Thesaurus option.

-

| o g =
‘w'_ s _ o . . 4 5 ‘1‘.“ ¢ dl L ey -
o o= Py J A - " g‘;-]’ 2 B J
v b > 4 .o pp _!1.-\ ark - _""“
'.’ - vy Yy _ ALTeDT Rawsyg 3)
b il E’g,_‘_ 2 Pare d
/ _ — Review tab
Proofing group | Research v

Using Review tab to access Thesaurus option market 5
Thesaurus: Engiish (Untadsn”
The Research task pane appears. B

Y ™t i =

&
® The Search for: field displays the word you have selected and J{Sm:;r;:;fggllsh
for which you want another word. It also contains the drop-down | o morketplace (1)
list of all reference books. Here, Thesaurus: English (Uniteq | "o °
. . . uk Fl] Inset
Kingdom) is selected. | :i':ar : j: |
| - [ e opy |
® Below it, a list of the suggested synonyms appears. To use one | jmww-
of th d ' 01 lick the . | advertise :
© words, pomt to 1, click the down arrow key. Click Insert | on
or Copy from the drop-down list. e
J(;j Can't find It?
& alternates
:;m:rp%:hrfritsaon refining
your search.
Other places to searth
Search for 'market'In: ,
(3 Al Refe.re.nc.e Bocks
' I 31_ -éé'-séaich options... ...—--’/IJ
noconrch task P a
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Time 10 [N
& Create the following list in a Word 2007 document.
1. Computer Science 2. Social Science 2. Science 4. Mathematics
Civics Physics - Arithmetic
Geography Chemistry - Algebra
History Biology

S Click

. Background group = Page Borders option. Y —

- ® The Borders and Shading dialog box opens. | D — it o hogreem bk o e

3 Click on the Shading tab. N - B el
Select the colour of your choice in the Fill| | RERE— = l
section. B s | s | & — :‘.
Select appropriate options from the Style:| [ := B e, i
and Color: drop-down lists in the Patterns i [P S = : -
section. b 5 A =

®  Select the desired option from the Apply to: o . fotens...

drop-down list in Preview section. (. B3etzonta e | S

.~ ® Click on OK.

- BORDERS AND SHADING

- MS Word allows users to add borders and apply shading options to a page 'fmd the selected
text. A border is a line or a pattern surrounding the page or a cell in the margin area. You can
- set the text apart from the rest of the document by adding borders and shading.

= Applying Shading

- The steps to apply shading to a page in MS Word 2007 are given here :

Select the paragraph(s) where you wish to apply shading.

on FPage Layout tab => Page &imiaisens b o

Borders and Shading dialog box
Removing Shading
The steps to remove shading from a page in MS Word 2007 are given here :
®  Select the paragraph from where the shading has to be removed.

®  Click on Page Layout tab — Page Back

ground group —> Page Borders option.
L

The Borders and Shading dialog box appears.
®  Click on the Shading tab.

® In the Fill section, click on No Color option from the drop-down list.

®, In the Patterns section, select Clear option from the Style: drop-down list.
@ Click OK.

PAGE SETUP AND MARGINS

Page margins are the blanks spaces near the edges of the page. Texts and graphics are
normally confined or set over the printable area inside the margins. However, some items
can be positioned on the margins. For example, headers, footers and page numbers.

e
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| Page Setup

ge Margins but you | Mergins | Pepel :' wm

e

Margns

ork using the default Pa

1o the following steps - .
=] Sctup glOI.lp cod o 2. Gutter poution:

yout lﬂb ~ Page |1 e Lefy :-
| Odentation 3

box launcher. | e ‘
ars. It has three tabs : @ e

E:urna'l Landgran

Top 1" S Bottom: 5,

|
i ] 2
| Lot 1 | Right: %

You generally w
can alter then usil
® Click on Page La
Page Setup dialog

® The Page Setup dialog box appe
Margins, Paper and Layout. | B )

Huttiple pyges: ticrmal

® Select the Margins tab.
ins section, select the -

® In the Margins tab in the Marg I

desired option from : . .
Top:, Bottom:, Left: and Right: lists to increase Or

decrease sizes of the four margins. '
o the side or top margil

Gutter: list to add text space t |
bind. A gutter mMargi | s | (o] (s

of a document you plan to o T e —
ensures that text does not hide due to binding. Page Setup dialog boy

@ In the Orientation section, select :  yargin s
< Portrait option to print
the document vertically.
<« Landscape option to print
the document horizontally.
"® @ In the Pages section, select
the appropriate option from
Multiple pages: drop-down
list :
< Normal option for getting
the normal document.
< Mirror margins option for
setting the facing pages in
a document such as books
magazines, etc. Book fold View
< 2 pages per sheet option for printling two page on one sheet.
< Book fold option for creating booklets with the specific number of pages
® In the Preview section, select either of the option from Apply to: dro -dowx; list :
< The Whole document option. s '
< This section option.
) Cl This Point forward option
© i _
- liCc}l((O(ilnﬂ]l)iseiE;?;;bgﬁzon to reset the defau-lt values for the Page Margin. When ¥°
Yes fo apply the default lge}tfgzg\:ﬂl get the Microsoft Office Word dialog box. Click €

® Cli i
ICk. on OK for applying these changes in the current document
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it == Ok quickcKey)
Do you want to change the default settings for page setup? App‘y H eading 1
9 This change will affect all new documents based on \he NORMAL temnplate. Apply H eading 3
[ys ][ ™ | Apply Heading 3

Microsoft Office Word dialog box

APPLYING BUILT-IN STYLES

Styles are used for formatting the text in MS
Word. A style is a set of formatting instructions. In
MS Word 2007, you have a number of built-in
formatting styles. If the available styles do not
match your requirements, then you can create your
own style. The general idea is to modify a style to
suit a particular formatting need, and apply it to
the text or a paragraph.

Follow these steps to apply built-in style :

1. Select the text or paragraph.

2. Click on Home tab = Styles group = Styles list.

Click on Styles dialog box launcher.
From here you can :

9 use down arrow key to choose from the list.
)

A. Tick (v) the right option.

Apply List Bullet

Cancel

Hanging Indent

Copy Format
Normal style
Paste Format
Thesaurus
Insert Format

Show/Hide Option
Insert Endnote

Styles

OR

use Show Preview checkbox to see the effect’of the style on the
document j

-+ USE ‘CL‘E% All option to remove all styles from the document.

. . |
F "y : |

_'. DY %'. Rl |
=T s e |

1. Which of these is placed at the end of a document?

(a) Header
(c) Endnote
2. AFootnote in a document is used to:

L1 (b) Footnote

(a) give comments and references on the text
(b) provide extra information

(c) both (a) and (b)

(d) none of the above

2
.
Al

L1 (d) None of the above

Computer Sclence
*-Book-6

Alt+Ctrl+1

Alt+Ctrl+2
Alt+Ctrl+3

Alt+Shft+L
Esc

Ctrl+T
Ctrl+Shft+C
Ctrl+Shft+N
Ctrl+Shft+V
Shft+F7
Ctri+Alt+F
Ctrl+Shft+*
Ctrl+Alt+D

AIt+Ctr_l+Shft+S

[Styles. v x|

| | Cear au

| [ Hormal

| | Ho spacing

| | Heading 1

I Heading 2

| Tile

| | Subtrie

| | Subtle Emphasis
| Emphasis
| Intense Emphasis
: Shrong

[| quote
| Interte Quete

| | Subtle Relerence
| Intetie Relerence
|| ook Tre

|| Lt Paragrach

Bhin Pyeview

11 T Disable Linked Gryles

} ! Y
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ey

3. 1\ bv;]t I] Q l Lamnpnnrrer IIII(I{_ 4 l]elllnd he tEXt.
CI l]‘lf l{ l. € /('ll'l ans v .

a) transparent
9 l L1 (d) none of these

(c) opaque
4. Which short-ct

(a) Ctrl + Alt+ T

(c) Ctrl + Alt+D ] @ ctrl + Alt +A

B. Fillin the blanks witl
translucent

ta Footnote?

1t command is used to inser
(b) Ctrl + Alt+E

ETET

1 the correct word.
0.5 Indentation
. inches from the top of the page.

characters that can be inserted from the symp,

Symbols  Endnote

Thesaurus

1. By default, header is printed ...
are the signs and

........................

dialogue box.
line hanging over the rest of the lines.

i Tepresents the first
A Watermark iS @ .o IMAGE that appears behind the text of a document.

is placed at the end of a document.
looking up synonyms for a particular word.

e

o 1AW

ThE overescerrsrenes 18 fOT
State whether the following statements are true or false.

You cannot alter the default setting of Page margins.

Only pages can be formatted with borders in MS Word 2007.
Shading can be applied using Borders and Shading dialog box.

You can also give your own styles besides using built-in styles.

T

T W N -

Drop Cap feature is not of any use in MS Word 2007.

D. Match the following.

1. Hanging Indents (a) The text is right aligned.

:. gier;mal Tab Stop (b) The fractional figures are aligned.
4. Shg dt‘ Tab Stop (c) It can be applied to a text or a paragraph.
. Shading (d) The first line is a little more towards the

left than the following lines.

5. Mi i :
Irror margins (e) Itisused for making books and magazint*

E. Answer the following questions.
1. Define header and footer.

2‘ LR L R N R R NN R R RN ] ) samrwa
Where do you add a footnote and an endnote?

1 36
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3. Why do you use page numbers in a document?

% Design a cover for your school magazine. You may make use of the features of MS Word
2007 learnt in this chapter to do so. The cover page design should have the following.
e Aninteresting layout
e Attractive page borders
e Title of the magazine
e Name of the school and class at the bottom of the page (Footer)

¢ Month and year must be highlighted at the top right side (Header)
Implement the gutter margin on the left position.

Collect or type text matter for an article on Water Conservation and highlight the important
function in bold or italics. Add watermark effect in your documents.

Make a report on your favourite singer. The report should include :
e atitle page

e table of contents

e biography of the singer

e alist of his/her famous songs

e a list of awards won by the singer

o a gallery page showcasing his/her photographs, etc.

" [:Illlllnump Science . . _
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@ Lesson Extract — -

Data Source/Address Book
Mail Merge Documents
Creating the Main Document
Choosing the Data Source

Writing an
preview the Merged

Finish the Merging Process

d Inserting Merged Document
Documenf

In MS Word, the mail merge option is an
standard letter to many people at a time.
in your school may need to be sent to a number

and many others. For this we type the bod
multiple copies of the letter with names an

DATA SOURCE/ADDRESS BOOK

Data source consists of mailing list, .j_

for example, name, address, city, pil:l, Kabir
telephone number etc. The data 18 .-

. : ; Ridhima
organized in tabular form along with Rt
the field names. The data source is
associated with the main document, sO
its field names can be used in the mai
along with the main document.

Manas

e

For Uour % f
The data source can be MS Word Database file con

important feature. Many time
For example, a letter ann

y of the letter in MS Wo
d addresses of perso

n document and it becom

of people, inclu

JADDRESS
#605, Sector 2 Meerut
#105, Sector 20 Meerut
#24, Sector 35 Meerut
#645, Phase 11 Meerut

eyl PN

—

s, we need to senda
ouncing a grand meeting
ding the parents, SpONSOrs
rd and mail merge makes
ns available in the records.

250002 2576675
250002+ 2586498
250002 2618090
250002 2264080

es easy to merge addresses

taining the address or it can

y bea database created inother applications, such as MS-Excel, MS Access, etc.
__________________________________________ .\

MAIL MERGE DOCUMENTS

The body of the standard letter to be sent to all recipients is called the Main Document. It
also contains the required field names for carrying out the merge process.

The process of mail merge involves three main steps :

® Creating the main document, containing the body of the letter.
® Creating the data source that contains the records of recipients.
® Merging the data source and the main document.

Mail merge reads the data source and physically merges it with the main document 10
generate letters for all the records found in the data source. MS Word creates a new

L38 J:
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<City> < Pasral code> <Stares
<Country>
Dear <Trie> <First Name>

This &5 to mform you that the Annual D
Shastn Magar, Meerut. on Hov.S, 2015.

With regards,

Yours' sinceredy,

You are requested to attend the functian with yaur family.

We requesst you o SPare your vahsabhks time to grace this auspiciousoccasion,

BTN Syl Ee R m e oeiflle FA‘QhCrD-!“MBuC{O"I Aallhte Aalihoy A

el T TR A ‘- w meom E 3= gn et ] s Ve Loaimg  wandng | L Lican TN - '__t'“'"
' Py wrb
e 7
s i k

CT?:le‘b-t-ﬁtstrl.ame:q_astn.mm} Date; >
<Address-1>]
<Aditress-2>

3y function is going to be hekt at DAV, Public Schaal,

LR

£ Pagisce

tIrag

Frincipal .
DAV Pulifc School it
Shastri Magar, Meerut Bh s ;
R Y|
e T O T

Main Document

document by insertin
document.

The resultant document of mail merge op
with the information stored in the data file.

Let’s study the steps of mail merge in detail.

CREATING THE MAIN DOCUMENT

Using mail merge, you can create letters, e-mail
messages, envelopes, labels and directories. The
data document holds the text that repeats for all
merged documents. On the Mailing tab, you can

click on Start Mail Merge and select the
document type.

MS Word offers the following types of

documents :

® Letters : This option is used for composing
and designing mass mailings for which only
the recipient information varies. This

document type is also used for sending out a
f%nnal letter or invoice.

For Your Ilﬂ.&

g the new data from the data source into the structure of the template

eration contains copies of the main document along

Mail merge is a software function
y describing the production of multiple
i documents from a single template form.

| Envelopes Labels

Create

:E_Lj!l:w —

L

Insert  Page Layout

__'j] Letters

= E-Mail Messages
L3 Envelopes..
L) Labels.
=

Directory

HNormal Word Document

nb-‘-ﬂ Step by Step Mail Merge Wizard..

References Mailings

b o mmma

o ‘Computer Sciance



Wi CLid

i . e e sonlized e-mail to egqp, .
| [ [ ® E-mail Messages : This option is used to send adpgg voidad b e Iy
if l"m Multiple addresses in the form of To, Cc or Bee an
Envelopes : This option is used for producing envelopes. s s e
Labels : This option is used to print sheets of labels. Many addre e pnm‘édt
the same page in different label formats. i i
, ¢ Directory : This option is used to print a catalogue or any other documen at re%z
‘ printing multiple records per page.
-HOOSING THE DATA SOURCE
i CHOOSING THE DATA SOURCE R . g
! Once you have selected the type of mail (O o U
merge, you can make your recipient list or | =2/ Home nsert  page L2V RelerR00es 1] M
data source. Besi@es creating it in MS Word, = Ia _\ | mh&.b |
YOU can import it from MS Excel or MS i
Envelopes Labels  StartMaill  Select E s
Access database, Merge * Recipients - Recipient List Merger
The various steps to select your recipient are : e B Type New List.
Click on the Select Recipients button from ‘ Bl [0 Use st List
the Start Mail Merge group of the Mailing | | ihj__si'i‘i‘_fﬁ”‘_(?“"°°55°fl‘ff‘i;
tab. A drop-down menu containing various
options appears,
w4 m  The various options are -
¥ 4 Type New List : When this option is selec
: yp P
B Enter the name and address in the dialog box. Mail Merge Recipient dialog box is
when you do not want to use the entire database. It 18 used to select the re
recipients.
- bome ien Pagelayout References. | Maiings |
o i e s g
VR e e ==
Envelopes Labels  StartMail  Select Edit Highlight - 4}
Merge ~ F_{mﬂs_‘_fwlijs_t_nl Merge Fields
: ',J-’_‘E:,Ei}f.::’.;-’.’?;;‘&.i.;'..";‘1';.'2 :'.-"?1 E T‘Vpe New List..
@r“ém__ﬂ_n%mwm; ([ Use Existing List.
{ ,!j_.} Select from Outlook Contacts..
1]
!
Nl -
L e

» the Select Data Source dialog bo
appears. Navigate to selec

¢ an MS Excel worksheet or M
Access database or another type of data file, click o Use Existing List and then loca
your file in the Select Datq Source dialog box.
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[} =R RS

e " '
:_j’/! Home Insert  Page Layout  References  Mailings I"I""_:'“"‘:"::'M‘.__M" o h‘f
5 o e -
e cry. N, Dyl Digeriae * I
N R » .
'-——J J -'j rr*&#*q a4 M ( J.(:mlv-l“‘iP“'w“'“""r“”"
Envelopes Labels  StartMail[ Select " - Misronedt e Owta Co Ll
Merge ~ Bcc:pwn_ls'_ Recipient List  Merge | A s [iae] N WSOl Servorl anieclon .
Create lg,'] Type New List... .. :T:,,:. . -
[[k]l i.\! 1_3 Use Existing List.. R Vilaot
I} i.ﬁJ Select from Outlook Contacts... N Comypnite
- S — A I—— Lo Lowal rak (L)
Y o Nt}
® Select from Outlook Contacts : If you e
want to use your contacts list in Outlook, " ¢ Ylovtowon :
click on Select from Outlook Contacts. Wy P
"_J/ Home Insert Page Layout References Mailings I S ——f—_;:—#'“""“—_ = - o |
— = Sy = Mail Merga Recipients |-t fotasd
" {3 HE L . n , Use the pptlons beloyr
) Ry o T e L T
Envelopes Labels Start Mail| Select | Edit Highlight A the merge, When your list s ready, dick 0K, S
Merge ~ ‘R'('_C'I]‘]I_EELPL'_EIIL___ lerge Fields Dola Sowr rﬁ'; —{luifm .|fr§mm .-ITl’ng -Icmwwﬂ_w_‘-vj
| Sieate ‘i Type New List.. - T2rmdE I N SRGR T T Ravi | petrol ] Sigh Filing St
@ LB |:] Usg Existing List... L i
i | | 6] Select from Outlook Contacts... I
Editing the Recipient List ks Wiy Refine redpient bet
In MS Word you have the options to select, | [2m® -] ‘i(l Sort..
5 . . | Filter...
modify and control your data. On clicking the | | }jmmm
Edit Recipient List from the Mailings tab, a | - " \Ee.
Mail Merge Recipients window appears. From = Validate addresses...
this window you can select or deselect an [
individual recipient. You can sort out of filter
items in the list.
WRITING AND INSERTING MERGED DOCUMENT Mailings ~ Review  View
Once you have created your recipient list, you will be able ERE :_j £
. . L = =y Match Field
to make the merged document. For this, click on Insert .. adiresscreetingmsernvterge =
) . . Metge Fields i jeld~ 1= RpatEd
Merge Field on Write and Insert Fields group of ' Pex tre _fed = 0 |
ays Lebuiad Title
Mailings tab. A drop-down menu appears. Select the B s T
a . irst_| |
option you want to choose to insert. Repeat the process | ) e
. . | 2 |
until you have inserted all the fields. | Company.Name |
PREVIEW THE MERGED DOCUMENT I Pl
| ress_Line_ |
Click on the Preview Results button in the Preview | cy ?'
Results group of the Mailings tab. It helps you to | swe 5
navigate through the recipients in the data document. | amnnee
. .. . F; g | Country_or_Region |
You can search a specific recipient in the data list by | Home_phons =
clicking on the Find Recipient button from the Preview | Work Phone .'
Results group of the Mailings tab. A Find in Field box || EmalLAddress _[
ﬁ
|41 |
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appears on the screen, On filling the required information in the boz, the firg Ty,
matches the search criteria appears on the screen.

FINISH THE MERGING PROCESS

By merging the data document with the data source, you can create z printed etz
({ncunwnt oran c-maled document, You can complete your mzil merge by Chlcing o .
Finish and Merge option from the Finish group of the Mailings 12b z2nd selecting one ..,
options from the drop-down menu.,

{ vy alsmn - 4 » . " by = et - -
\c_m can take the printouts of your letier with the merged data of your dztz source. In ..
print the letters, follow the given steps

E.

e s

/ J,r----q"-_,::..,,‘u,_,;‘ ﬁ"r"/’}!
ok [ irues fintd = _‘]/ Juste, vy e Gaveme 1 fareos
gy P e _:_] o

55_3 Srt Desrneere

wig Pl Vessseer

———

@ Cli(:'k‘ on Finish & Merge button in the Finish group on !"‘—lu
Mailings tab, and sclect Print Documents option from the Fzna

Merge™
2

drop-down menu. =

£ ) Bt bdid s Dimreres
&3 Erint Documens..

iy Send E-mzd Messages

ost Eour Uilrain

A. Tick (v') the right option,
1. Mail merge is an important feature of

@62

.-

(a) MS Access L (b) MSWord
(¢) MS Excel L1 (d)MSWindow
4. Finish and Merge option is present in ............. group of the ........... tab.
(a) Mailings, Finish [b)i‘*'inish, Mailings
(c) Finish, Insert (d) None of these
3. Preview Results option is present in ............. group.
(a) Preview Results L1 (b)Preview
(c) Results L (d) Messages

ST
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4.

Type New Listis an option in ................ button.
(a) Start Mail Merge [ ] (b) Select Recipients
(c) Edit Recipients List [] (d) None of these

N

Fill in the blanks with the correct word.

1

G.

MS Access Mailings Mail Merge Main Document
MS Excel Preview Results recipientlist ~ Data source
....... cONsists of mailing list.
The body of the standard letter to be sent to all recipients is called the ... .

25 . is a software function describing the production of multiple documents
from a smgle template form.

Data source is also called the ...

The data source can be created in. el 1 <N

Preview Results button in the .. .. group of the ... tab is used to

preview the mailing result.

State whether the following statements are true or false.

1.
2

:

Data source contains the text that we wish to send to all the recipients.
Preview Result option on Mailings tab displays the first record from the data
source.

Mail merge is used in an orgainsation to send a standard letter to many
people at a time.

Another name for address book is Mail merge.

The two main components required during a mail merge process are the
Main Document and Merge Field.

[

i

L

Answer the following questions.

1.

What do you understand by the term Mail merge?

Whatls a Da;.;;.urce?

What s a Main Document? )
Write the important steps involved in Mail merge.

Write the steps involved in previewing the Merged Document.

g ComputerSciense . (et



urce for inviting her friends to her birthday party, >

. red a data so _ ; :
6. Renu has prepa friends on the basis of their place of residenc, b
My

on she wanted to sort out her
would she do it?

...............................
--------------------------
----------------------------

. Place the six steps to create a merged document in a correct order on the ladder.
Complete the merge
Select starting document
Preview your letters
Write your letter |

Select the document type

Select recipients

Computer Science
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. Adding Graphics and Pictures 1o the Slide  « Animating Teszt and Objects
Creating Tables «  Adding Trarsition
Inserting Charts < Importing Data frorm Word

. Inserting Audio and Video Files

MS PowerPoint is a powerful tool which helps us to communicate over views and ideas
s;_- cffcctwcly using diagrams, photos, cliparts, sounds, colors, designs and animated special

- cffects. It is the most popular presentation software. It is available as part of the MS Office
-~ suite.

A PowerPoint presentation comprises of a series of slides. A slide can contain text, graphics,
- Clip Arts, sounds, movies and animation.

* In this chapter, let us find out ways to use graphics and animation to make our presentation
" attractive to hold the attention and interest of the audience.

~ You can add sound and music from the files on your computer. You can even download these
.~ files from internet or Microsoft Clip organizer. Further more, you can record your own
sound and add to the presentation or use music from a CD. Let’s quickly review some of the
. features of PowerPoint.

| ADDING GRAPHICS AND PICTURES TO THE SLIDE

Adding Graphics

~ The Microsoft Clip Organizer contains graphics, photographs, sounds, videos and other
- media files, called clips that can be inserted and used in a presentation.

. The various steps to add a picture to a PowerPoint slide are :

; ®, Go to the Insert tab and sclect Picture button in the Illustrations group. An Insert
- Picture dialog box opens on the screen.

®, Browse to search the picture from your files on the computer. Select the picture.
. ® Click on the Insert button. The selected picture will be inserted in the document.
®, To relocate the graphic, click and drag it to the place you want to reposition it.

a For Your ILLEO‘ S

A PowerPoint presentation is stored as a file with pptx extension.

, =
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Adding Clip Art

Clip Arts includes the picture files that can . as-o s
be inserted into a slide of your presentation. 2= i o al Q) AD T 6
The various steps to insert a Clip Art are i = e ':' == ) L,
® Go to Insert tab to select Clip Art i S ".:.f:'/ '
button from the Illustrations group. fowan

The Clip Art task panc will appear.

® In the Search for box, type the word or
phrasc of the picture to be inserted and

click on the Go button.
@ The list of pictures will appear in the

task pane.
@ Click on the Clip Art to insert it in the

slide.

Editing Pictures and Clip Art
When a graphic is inserted into a presentation, an additional tab appeares on the Ribbon. Th

-‘:.-.,I

Format tab allows you to format the pictures and graphics. This tab has four groups &

Adjust : It controls the picture’s brightness, contrast and colors. SR
Picture Style : It allows you to place a frame or border around the picture and add effects

Arrange : It controls the alignment and rotation of the picture.
Size : It allows you to resize the graphic.

Gtk b 93 ety
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iding Photo Albums

ie photo album is a new feature in PowerPoint 2007 that allows you to create a photo

bum easily.
eps to create a photo album on the slides are :

' Go to the Insert tab and click on the Photo Album button from the Illustrations group.
Choose the New Photo Album option from the ‘drop-down menu. A Photo Album

dialog box opens.
) Click on the File/Disk option to see pictures

from your files. Select all the desired pictures ¢

and click Insert. The last selected picture will *

You can even add notes in your photo

be displayed in the Preview box. The numbers = album foryour presentation.

and names of all the pictures will be shown in
the Pictures in album box.

) Click on Create button to insert the pictures in your photo album.
)nce you have created your photo album, you can add text by clicking on the New Text
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CREATING TABLES i e a1 i
T . ditional features to organise the informa bulay o

PowerPoint provides additiona e seenpe yelugl: o fo,

table is a grid made up of rows and columns. The inte U

; . Ng

IeClangular boxes. These are called cellsi. Columns are Vemsai S?Eeznoife;ﬁ Wherg :
are horizontal series of cells. A table is used to dlSPlay o d Sanised Way
Presentation. It is inserted at the point where the cursor is pOSlthH? : |

The various Steps to inserts a table in an MS PowerPoint pr esentat-IC!l are . _

@ Place the cursor op the page where you want to insert a table in the presentatiop,
@ Go to the Insert tab of the Ribbon and select the Table bii.ton on -the Tableg groy

drop-down meny appears. You can create a table in one of the four given ways,

“ Highlight the rows and columns for your table in the drop-down grid
accordingly the table js created on the slide.

|
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own menu. The cursor will change to
table. The Table Tools appcar on the
and selecting a style from
o keep the pencil below

.. Click on the Draw Table option on the drop-d
a pencil. Drag the pencil to create arca for your :
ribbon. Create your table by using the Draw Table option
the Table Styles group. While drawing the table, take care (

the border line. ag e . ; .
i [rees- boaert [rvaenn, T P vy Y = - L] Deaagr | Lyl i ¢ v}
2 A - s j o

b ekt g 9t 3 i e 1 s POue, o B s : TR [ Ty SR O 18,80
e Click on the EXcel [ prmso o |
Spreadsheet option on the """ '
drop-down menu. A small = e e e e , Y
Excel sheet box will appear. | D)5« v #¢ 28T TN, amil aen A
Click and drag the sheet to | .~ " S o Ll Wl =<~
get the desired size. Clickon = * | ° £ ey
each cell and type your data. | ‘
‘.i }

ek sheetl “. 191 .

& Al
Chick to add notes

]' Cide 19d ] 0w Thare™ 30

Modifying and Formatting a Table

Once a table- is created in MS PowerPoint, you can easily modify it. To modify the structure
of a table, click on the table. Two new tabs will appear on the Ribbon: Design and Layout.

Click on the Design Tab and choose one of the options fr
om the Tabl
a new design for your table. P B

-
{ \ o = N
!&.‘] t‘i 98- Pronsriati ol Microsoft PowesPoet Tabée Tooh o R |
- e uen . - - £l
n Detgn | Arevatong © Skde SDhow Frcew . View  Desgn | Layout w
4 b o Fart ol _.—-—-_._i Py
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Design tab

Tt Syl Optiong

_dg@  ComputerScience



2019

k
E
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"
s to format a table.

you get many option ;

yout tab of the Ribbon,
(Table Group)

& Columns

Group)
(Rows & Columns Group)

On clicking the La
) View gridlines and propertics

Insert rows and columns (ROWS

Delete table, rows and/or columns
lit cells (Merge Group)

)

e

(€]

@ Merge of sp

® Increase and decrease cell size (Cell Size Group) ’ el

®  Align text within the cells and change text directions (Alignment Group

®  Fix the height and width of the table (Table Size Group)

@  Arrange text of the table (Arrange Group)

?.‘5 ;}-.l__n-u ‘= . ‘. o e U ,r“.,,.,,_l r - B
o s e E o e ae mmw i O DR SR
P 5 e 98 iR 2 [ oiwnbae ot ERE 1 L o TeSortoe

Layout tab
INSERTING CHARTS
rksheet in a graphic format. N

Charts allow you to present information contained in a wo
Line, Pie, Bar, Area, Scatter, e

PowerPoint offers many types of charts including: Column,

The various steps to insert and view a chart on a slide are :
Click on the Insert Tab to select the Chart button from the IMustration group on

.
Ribbon. An Insert Chart dialog box opens on the screen which displays the varic

charts available in the template of MS PowerPoint.
Select the type of chart you want for your MS Excel document containing your data.

@ C(lick OK to insert it.
& Once a chart is inserted on the slide, a new Chart Tools button appears on t
Design tab. It displays many styles of charts and chart layouts to choose from. Y

can select any chart style or chart layout for your data.
By default a chart is shown along with an Excel document containing the data.
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gdit Chart Data

The various steps to edit chart data in the presentation arc :

@ Select the chart.

® Go to the Edit Data in the Data group on the Design tab. The spreadsheet containing the
data opens on the screen.

® Edit data in the spreadsheet. The chart in the slide will show the changes in the data of

the spreadsheet.
r_!' an- ¥ J Microunlt Porambarn | I . = ¢ =5 ; 2 -
vt it . : Wow | Revew  View ' Devg Loyesd Fooma B . ot Page Lapest  Tewrmide TR W
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INSERTING AUDIO AND VIDEO FILES o .
. ) R eeder -
MS PowerPoint has several features which §1j Mlnd F &

help you to make the presentation more “-> A speaker and a sound card are required

interesting. It allows you to attach sounds in the computer to play music and sounds.
and music to your slide. You can also record

your own sound and add to a presentation or use music from a CD. Similarly, you can add a
movie or animation to a slide and make your presentation attractive.

Adding Video =
Video clips can also be added to a presentation by following these (g:') u@
steps : [ Movie ' sound
® Click on the Movie button in the Media Clips group of Insert .~~~

tab. A drop-down menu appears. &3 Movie from Eile..
® Choose Movie from File of Movie from Clip Organizer.
On choosing Movie from File, an Insert Movie dialog box appears on the screen. Browse to
select the movie from your files in the computer. Select the type of file and give it a name.
On selecting Movie from Clip Organizer, a Clip Art task pane appears on the right-hand
corner of the screen. Name the Clip Art in the Search for box and click on Go. You can
select the type of media file from the Results.
On clicking the Slide Show button at the bottom of the screen, you can see the animated
form of the Clip Art. You can download video clips from Internet and insert them in your

slide. D
151

il RN é

= PN PR A

Movie from Clip Organizer..




, i) BlackE" = — -
Cvan Magenta i B : :
* it #

e
o ol vl
ol =M Y 5 |
N £
B o s Pl oy %)) '.s.| }_’-'j §
Y 04 DO S
r I‘ A - Uide -
: | m n’ﬂ : = I:\‘f’w. L M e o [

N hom Clp Oraanat: |

B — ot ]
: e . iy < |
e R |

‘? For Uour IH.EO‘
y

romem | | ge— v mp—

o

= e

¥ effects to the video file selected for the presentation.
i

Adding Audio -

el

scantation] - !croqoti’r'wwf-'ﬂn'l

There are many options available to give SPECIAl  ipions  Sideshow  Review  View

Picure Tools |, Movie ools
Forma Optiars

o TR K ogees
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Audio clips can be added to the presentation. The various steps to add \@

an audio clip to a slide are : Sound |
@ Click on the Sound button in Media Clips group of the Insert -
aﬂ Sound from File..
tab. A drop-down menu appears on the screen. : ;
. . . Sound from Clip Organizer—.
@ Choose Sound from File or Sound from Clip Organizer or Play Play CD Audio Track_
CD Audio Track or Record Sound optlon Becord Sound..
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) For Your Iﬂgﬂ‘

‘2 You can edit an audio  r, dn-0 - TR
 file with the help of the Y Wore et Desn - trimsions S Shom - Revew
| options available on | _‘.3_',;; i 3 e
| the Format tab. N e - |
----------------------------- R e et TR bt i b A At L o R L
ANIMATING TEXT AND OBJECTS

Animation is the process by which multiple pages are displayed rapidly in a sequence such
that the images appear to be in motion. It is the addition of special visual/sound effects to the
text and graphics on a slide.

Animation can be used for any or all of the following purposes : !
® To emphasize on important information in the slide.

® To control the order in which information is displayed on the slide.
® To hold the attention and interest of the audience.

You can set the timing and order of the animation.
Slide Animation

Slide animation effects are predefined special effects that you can add to objects on a slide.
The various steps to apply an animation effect are :

M Hﬂ'\_! = . Mieresen PP o o -
= : i 7
- Home  Insent Design Anirnalions Side Show Review Wi ;
= = 5 - d, Toansition Seund 1 A (e S
I }.‘ J i lr "h “I i'w:l "'.-«_;’". “"E' UH Trasmition Speed Fast = Dmodbase Chck
- ! § e il =5 ) s —
) Custom Animation A —_— - — = e val appty To Al & poarativaily Aler DIUG

Animatian Traraiton 1o This Slade

® Select the object you want to animate.
® Click on the Animation tab on the Ribbon and select Custom Animation from
Animations group.
A Custom Animation task pane appears.
® (lick Add Effect. A drop-down menu appears -
on the task pane. |
® On selecting one of the options from the drop-
down menu, another menu appears. Choose the | |
appropriate effect from the sub-menu. Motion Paths P | 3% 4.Diamond
® In the task pane under the Modify Box, there are | = Movie Actions b | # 5 Fyn
three other option available : Start, Direction - il ey

and Speed. s . | e
Start has three more choices (1) On click (2) With previous and (3) After previous.

_ ; . 1 i i hange
Aniimation event begins on clicking the mouse on the slide. The other two options chang
with th:: 313::; of t%e effect option. You can S€e the effect on the shde: by clicking the Play
button or see it in the slide show when you click on the Slide Show optlon.. .

Yo can see the preview of the animation on a slide. Select the slide you wish to preview and

click on the AutoPreview button. ¢ 53 |
' Gomputer Sclence B
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| Custorn Animation v X |
Efr AddEffect ] [%. Remove |
Entrance P =% 1.Blinds o
Emphasis P 2 2 Box

Exit 4 3’ 3. Checkerboard
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ADDING TRANSITION ) :
Transition effects are the movements you see when one slide changes to another in Slig

Show view. Transitions are used to add visual effects to the slides. You can apply transmu
effects to a single slide as well as to all the slides. Follow these steps to add transity,
effects:

@ Select the slide you wish to modify. Click on Animations tab.

® Transition to This Slide group appears on the top. By default, No Transition is applig

to each slide.
@ Click on More drop-down arrow to display all the transition effects. Click on an

transition effect from the displayed choices.
@' The current slide will display a preview of the selected effect.
@ Select the desired speed from the Transition Speed drop-down list,
@ Click on the drop-down arrow of Transition Sound and select any sound effect of you

choice.
@ Click on the On Mouse Click checkbox if you want to advance the slide manually b

clicking the mouse.
® Click on the Automatically After checkbox if you want the slide to advanc
automatically to the next one. You can specify the slide advance timings also.

@ Click on Apply To All button to apply the selected effects on all the slides. Otherwis:
those effects will be applied on the current slide only.

Piesentationt - Miciaenf PevmerPoint . M
Aot Clide &)y Feview View : Bpaias ey
ooy A Al l tk Tiansitien Seiiiel [Fien R | 2 ffvt!r!'!ﬁt'&'gﬂﬂé .
| 5% 2y m fo ;.-'ii [ e [ o P ! i / | 2 5 R
JII J JJ “ !} - ’i‘ rf’-?ﬁg ? E—‘ Js' "&I © WY transitian Spesa rast 1 VB Maisa Eliek

el Apply ta Al LT Autematicafly After 0099

Trangition i This Gflde

Adding Transition

You can also apply transition effects in Slide Sorter View. Open":;&nimation tab and selec
the desired slide transition effect,
! !

[54],
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IMPOFITING DATA FROM WORD
powerPoint has the facility to import

and use data from Word, Excel, etc. Importing data

saves your time and efforts. Follow these steps :

@ Click on Start = All Programs

| ‘O &l 9-0 = AR
— Microsoft Office => Microsoft | = osr  tore et fogeiamt  Sefersnces  Mubogs  frew Vi “'l
Office Word 2007. Click on the | # # i - s “omesc o) 8
Outline button in Document @ * * * - Sl 42 st oo Y
Views group on View tab. !j : 3 !|
o Type the text shown in the figure | & Mrmitoond .
and click on Close Outline View ! © Microsoft Excel “"'|
button to return to Normal View. g (C::t: :J)tll.?.‘t‘;:-lraxills
@ Select “Types of Software”, and & © flsh i.J'
. 2 Adohe Photoshop & ]
apply Heading 1 from Styles | A
group on the Home tab. | K \|
@ Select “Microsoft Word” and | 1
choose Heading 2. ll ?' '1
® Select “Microsoft Excel” and | Y|
apply Heading 3 from the | il
selection. |‘:d1_["’“ R RS i AL LA M SV L I S et :
® Similarly, select “Corel Draw” and "7 " = MO » Ot
apply Heading 3 again. Importing Data from Word
® Apply Heading 1 on “Corel o R S &
Photo-Paint” and Heading 2 on | (i) . » Conpue v thontolne(t v % 75
“Flash” and “Adobe Photoshop”. Orgarin + M lekdor : 7z
® Click on the Save button on the | oo, ~ " oo
Quick Access Toolbar. The Save | ¥« A i
As dialog box appears. Type the | mus S et SRy
name “Types of software” in File T b fapsh Gopta
name text box and click on the | & reaws & it AR HE
Save button. Now exit from - 1 tyves of saftume /014 159 A /
Microsoft Word. i LN ” :
® Start Microsoft PowerPoint .and e IW'WMM oy ,
open any existing presentation. S oy | B
Click on View tab and select on | ... S

Slide Sorter button.
For Your I‘&

To print a slide with the default settings,
B Click on Print option in the Office Button

menu

mrmamEmaSESASTScEsEsSIRESsmsasAsSR H
semm e 555
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@, Now, click on the New Slide drop-down menu on Home tab. Select Slides from Ouuim

option. .
& The Insert Outline dialog box will appear. Browse the location of the Word file-Typ,, !

software.

®, Select the file and click on Insert. . ' '
® New slides will be inserted in the presentation. View the new slides.
O, H9-0 = e e L = L o

-~ - Arikateng . Thiw Vhoa  Bpdew e

[

bams b
£ R B [Tl v | } ! £ : - -t
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For Your Iﬂgo’ .

Action buttons do not havetg
y be inserted on master slides,
i You can insert an action
E button on a slide, if you wish.

i — o —

fy

e Sorter  Tiw Trwerw™ s & g N 1

Importing Data from MS Word to a New Silde

ctrl+D

5 btz e |
Aei

A. Tick (v') the right option.
1. The default extension of MS PowerPoint file is
(a) .pptx ] (b).doc [
(c) xlIs l:l (d) none of these [
2. Transitions effects are the movements you see when

(a) one slide is created inside another slide t
(b) one slide changes to another in Slide Show view .

Gomputer Science
Books6 -, -
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(c) one slide is created after the other
(d) none of the above

3. Animation is done in PowerPoint
(a) to highlight the important points
(b) to hold the attention
(c) both (a) and (b)
(d) none of the above

and interest of audience

npono LE

4. Intersection of a row and column is called 2

(a) Table L1 (b) Cell border el

(c) Cell L1 (d) None of these B
5. To preview the transition of current slide, we click on the

(a) Slide Show button [] (b) Play button [l

(c) Nothing [1 (d) Anything ]

Fill in the blanks with the correct word.

Apply to ALL  transition presentation sound .pptx extention

PowerPoint is an application software for creating ... .
A PowerPoint presentation is stored as a file with @ .....ccouerrurene

The way one slide follows the other on the screen is called ......c.ccovuiren. .

e

To apply the transition to all slides click on the ...........e........ button on the Animations
tab.

5. We can add sound to a slide by clicking on the arrow next to ... button,
Answer the following questions.
1. What is PowerPoint? How can you insert pictures and clip arts in your presentation?

2. Write the steps to inserta chartina PowerPoint presentation.

3. How will you edit a chart?

4. What do you understand by Animation? How is it helpful in a presentation?
5. What is meant by Transition?

6. Write the steps to insert a table into a slide.

e T T T L L L L Lt R L L e L L R e AL L]
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o on ‘My Class’. The presentation should have slides on class tege \
subjects taught and subject teacher’s details t]\
' a.l

&  Create your presentatio :
class location in the school premises,

strength and children’s details, etc.
2  Your school has raised some fund from each class i.e. 1 to 12 for the orphanage of y,

city/town. The computer teacher has given you the responsibility to keep the records gf“:
fund. Create a table in PowerPoint and define the collection from each class. Further Conye

the data into a chart.

Prepare a PowerPoint presentation on ‘My Ambition in Life’,
1. The presentation should basically cover what you plan to do when you grow up.
2. Give transition effects and animations in your slides.
3. Insert pictures and ClipArt wherever required.

Comnuter Reiones .
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s+ Programming Languages
» Processing of Computer Programs

puter programs. A program is a sct of instructions, which )

< Algorithms
Flowcharts

You have heard about the word com
)

en executed, ma : . -
wh » makes the computer work in a particular manner. Programs arc an integral part é '}
a
3

of a computer. Computer will be useless if it has no program. Computer program dirccts a
computer how to process and execute data.

PROGRAMMING LANGUAGES

A program 1s written in some specific language called programming language. Sincc
computer does not understand natural languages that you speak, so specific languages are
developed for it. Computer understands programs written in these languages. These
languages can be easily translated into machine level language, which a computer
understands using compilers, interpreters and assemblers. You will learn about these terms
in this chapter at a later stage.

A person who writes a program is called a computer programmer. To perform any task,
programmer writes the set of instructions or programs in one of the many programming
languages.

Programming, with regard to computers is defined as a process of designing, writing,
testing, debugging and documenting a program.

Programming languages are divided into the following types :

® Low Level Languages (LLL)

® High Level Languages (HLL) :
Low level languages are machine oriented languages. It means, these are directly
understood by the computer. These languages are generally machine dependent, i.e. they
cannot be easily used on another computer with a different configuration and processor.
These languages are difficult for a common programmer to learn.

Low level languages are again of the following types :

® Machine Level Language (MLL)
®  Assembly Level Language (ALL)

Machi noguades : . .
Y, il A an understand only special signals, which are rcprcsenteq by !s
ou know that a computer ¢ s. Computer understands programs written in

ioi inary digit '
g?fa?;.di‘hltzse;\; Oli;ggltlsa;e :;ﬂzﬁ 3;23 b);nargy digits, is called the machine level language.
igits. The , _
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Assembly Level Lan uages o aene These € ,
v 9 . otead of binary digits. These symbols are call,

These languages use letlcts, ; s arc called assembly ¢4 ¢
Mnemonics. Programs written 10 instructions. Asscmbly 1,&,:‘
4

Assembly codes arc translated Mto muclpn T ATE
language is easicr (0 understand than machine Jeve anguage.
High Level Language (HLL)
High level languages arc easier for a hum
not dependent on any particular computer m
Advantages of High Level Languages .
There are many advantages of high level languages. These arc as follow'.s :
1. Understandability : Programs written in these Janguages arc casicr
read them in assembly and low level languages.

Debugging : Debugging simply means to T€

programs written in high level languages are €as
achine can run

3. Portability : Programs written for one m
minor changes or no changes at all.

Example of High Level Languages

Some examples of high level languages arc - BASIC, LOGO, FORTRAN, COBOL

PASCAL, C, C++, JAVA, VC++

BASIC

BASIC stands for Beginners

language.

LOGO

LOGO stands for Language Of Graphic Oriented. It is also a

figures and do sums.

FORTRAN
FORTRAN stands for FORmula TRANslation. It is used by engineers.

COBOL
COBOL stands for Commo
for business purposc.

PASCAL b
Pascal is a general-purpose language named after the great scientist and mathematici?

Blaise Pascal. It > » very powerful computer language. It is used to develop mal

application programs.

C
C is also a powerful computer language. It uses structured programming approach. It us usff

widely for developing application programs.

C++ |

ﬁ&iéﬁ?ﬁ;ﬁ?&?ﬁwi as an enhancement of C language. It used the concept of obie!
s g. is also a very powerful language used to develop diifere_;-'.

Computer Sclence
Book-5' ‘

an programmer (o understand. They are genery
i )

achine.

to understand g,

move errors in a program. Errors j

ier to find and remoVve.
on different machines with vey,

2

All Purpose Symbolic Instruction Codes. It is a very simpk

simple language used to drav

n Business Oriented Language. As the name suggests, it 1s use




applications. The user-friendly and an enhanced version of C++ is developed by the name,
visual C++ or simply VC++.

JAVA
Java is a modern day language developed by Sun Microsystems. It also uses the concept of
object—oricnted programming. It is nowadays very popular and used widely.

PROCESSING OF COMPUTER PROGRAMS

High level languages are designed, taking into mind the ease for the programmers. These
Languages are not understood by the computer because it only understands Os and 1s. To
make the computer understand a program, it is converted into machine level language.

A high level language is translated into machine level code by a compiler or interpreter.
This process is called decoding of programs.

There are three types of translators. These are :

® Assembler

@ Compiler

® Interpreter

Assembler

Assembler converts a program written in assembly level languages into machine level
language, i.e. assembly code into machine code.

Compiler

Compiler translates the whole program completely in a single operation. A program written
in high level language is converted directly into machine level language.

Interpreter
An interpreter translates a program in a step-by-step process. It is slower than the compiler

process.

ALGORITHMS

Everyone does some work from getting up in the morning to sleep again at night. All works
are performed in steps. For example, you get up from bed in the morning, brush your teeth,
take a bath, have breakfast and go t0 school by a school bus. You have to follow these steps
inan order. For example, you generally do not take breakfast before getting up from the bed.

Therefore, you need to follow a systematic way to complete any work. These steps of a work

or problem together is called Algorithm in computer. |
Algorithm is the step-by-step process of so_lving any problem. You need to write programs in
“Omputer language to solve any problem 1n a computer. Progralgsoare a set of instructions.
Algorithms are written in a step-by-SteP procedure before writing the actual computer

Program, So, algorithms are an important part of program development.

FLOWCHARTS

A flowchart is a graphical representatio
Qgical Ordcr_ .

n of an algorithm in which steps are laid out in a




drawing a specific 8€0mey,
to illustrate the sequenc, T
using standard symbol 0
the sequence in which i

h operation IS represented by

shape. These flowchart symbols are connected by 31“1'0W5b
operations. A flowchart conveys all information v1suelly Yt
represent these different functions. It uses arrows to represen
instructions should be performed.
Thus, a flowchart conveys the follo
The sequence in which steps should be per
The steps involved in obtaining user input
The steps describing processing of data.
The different conditions involved in handling the process.

The steps to be repeated.
Standard Flowchart Symbols
Before we start drawing our first flowchart, let us get
symbols.

Start/Stop symbol : This symbol is used to indicate the beginning
or the end of the sequence of steps.

Input/Output symbol : This symbol is used to indicate the /
acceptance of inputs from a user or the output or the result

concluded.

Flow lines : The flowchart symbols are connected with the help of
flow lines. The arrow direction represents the flow of the sequence.

In a flowchart technique, €ac

wing information :
formed.
or giving an output.

familiar with the standard flowchs

Processing symbol : This symbol is used to represent any step that
involves the processing of data.

Decision Box : This symbol is used to represent a step in the
algorithm that involves a decision taken on the basis of a specific
condition. Decision box may have two branches leading out of it to

represent the cases of the condition being true or false.

Connector : This symbol is used to connect any two points of the
flowchart to indicate the flow or sequence of steps, especially
when the flowchart, involves multiple steps.

Simple Flowchart
Let’s now draw a simple flowchart to find the areas of a circle, if its radius is given.

7 For Your IN&T
‘W The general direction of flow in any flowchart is from top to bottom or left to righ

[62].
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pranched Flowchart
gometimes, the flow of ste

: PS in an algorit
into multiple paths based gorithm can branch

on how a particylar condition

’ g = > You need to have
alternate plan involving indoor games, =

Is it
raining?

No

Play outdoor games*\
Yes

| St::)p |

A branched flowchart

Play computer games

A

This branching in a flowchart is caused due to some
conditions. It is shown by the decision box in a

4 Mingl Peccerye

IR flowchart can f\éve only one.
Startand one Stop symbol.

/ Read radius, r, of the circle /

h 4

Area=3.14*%r*r

f Print Area ;
| Stop |

flowchart to find area of a circle

Cstart )

flowchart. /
Looping Flowchart

Obtain the list
of numbers

b 4

. Sometimes, some steps in an algorithm
. have to be repeated for a given number of

b 4

Largest number = First number

-~ times. This is known as a loop. A loop is
the sequence of instructions that repeats a
specified number of times until a
Particular condition is met. Let’s look at
the flowchart corresponding to the
algorithm for finding the largest number
in 2 list of numbers. This is an example
of looping flowchart.

next number >

Any
other
numbers in
the list?

number

| Stop ]

No _/Output Iarge57

Is the

Largest
umber?

|| Largest n

umber = Next number

-

A looping flowchart

]

Computer Science.
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@ | oat gour rain |

A. Tick (v') the right option.

. €an be defined as a set of instructions that €
athematical probica.

L (@ None of these L

an be followed to perf
T

1.
logical or m

such as solving @
. (c) Connetor

s.pecific task
|_j(b) Flowchart

(a) Algorithm
5. Aflowchartisa graphical depiction of a P2} B
(a) program [] (b) symbol [] (c) algorithm [ (d) flow chart [
ate the beginning and end of a program.

symbol is used to indic
W > Lwm(C ) = [T Ay
4. Symbol of input/output box in a flowchartis

@ > Lm/ rimic A ™ @< B

5. Programis
(a) an algorithm
(b) steps written in English language.
(c) both (a) and (b)
(d) none of the above

written in a programming Janguage and executed by computer.

6. Javais
(a) a machine Jevel language and not frequently used.

(b) a language used for internet-based applications.

(c) both () and (b)
(d) none of the above
Fill in the blanks with the correct word.

Algorithm binary digits
Compiler or interpreter

il A K .

Computer program Loop |
Programming language Machine _Q_ri_ente_d_

A program is written in specific language called ....oeerressene: ;
9. Low level |anguages are s languages.

3. The computer understands programs 07 g 10 1=) 0 15 ) o AU ;
is a step-by-step process of solving a problem.

n a programming language is called @ ...coermrarenessness »
lated into the machine language by ... :
f instructions that repeats a specified number of tim¢

5. An algorithm thatis written i

6. High level languages are trans
y S e is the sequence 0

H Computer Science P .



c. State whether the following statements are true or false.

1. Aprogram is a set of instructions. [ i
2. Aprogram written in assembly language is called a compiler code. | j
3. High level languages are easier to understand. N
4. There are three types of translators. -
5 ’:‘i};;feneral direction of flow in any flowchart is from top to bottom or left to - |

p. Match the following. —
1. Qi]gw?hart (@) is used for input and output steps.
2. . Va}l 1 (b) is used to connect two different parts of a flowchart.
3. Aparallelogram (c) is a graphical representation of steps for solution to

. a problem.

4. A d‘lamond (d) is used to represent start step.
5. Acircle (e) is used for decision making step.

E. Answer the following questions.
1. What do you understand by the term programming?

-------------------------------------------------------------------------------------------------------------------------------------------------------
.................................................................................................................................................................................
................................................................................................................................................................................
.................................................................................................................................................................................
................................................................................................................................................................................

----------------------------------------------------------------------------------------------------------------------------------
--------------
---------------------------------

in the preparation of flowcharts in various sizes. Fill the symbols with

Draw the symbols used i I
different colours. Write the names of the symbols.

% __ Draw a flowchart to find the sum and average of three given numbers.

Draw flowcharts in MS-Paint for the following :
1. Steps required to switchona computer.

2. Steps required to shut down a.compu;e-; o
3. Steps required to watch a movié stored i :

PP _Comp mgegg&nwnne
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Programming with

"%

% - Lesson Extract A E:L&

What is QBasic? + Running a Program % Constants and Variay,
Starting QBasic + Exiting and Opening QBasic  ++ Operators ‘
* Saving a Program < Character Set of BASIC % QBasic Statements

You know that computer is a machine that processes the data and gives the desired result
The set of instructions given to the computer is called program. These instructions must be
written in a programming language that the computer can easily understand. BASIC is op
such programming language. There are different versions of BASIC such as GW-BASIC,
Turbo, BASIC, QBASIC, VISUAL BASIC, etc.

WHAT IS QBASIC?

QBasic is one of the versions of BASIC. QBasic stands for Quick Beginners All Purpos
Symbolic Instruction Code. Some of its features are :

@ Itis a simple computer language.

@ It is very easy to learn and use. |

@' It uses English like words and mathematical symbols to write programs.
@ Itis a high level programming language.

@ It helps us to write, edit and execute programs.

STARTING QBASIC
Look for the QBasic icon on your desktop and double-click on it to start it.

QBasic window appears with a welcome message on the screen when you open its 4
version. The welcome message does not appear in QBasic 7.1.

B A Vi

(W qudanscyas T
Npcesoh Quekaisic) : : _
A =
Fesprd L
- C Ueleome to Ma-bos bbasls
¢ ® el 3 gt Commengn, (o0,
QBasic icon|*“* 1x . Brees Enter to wes the Burvival ¢ 4%
i & Pesdd ESC b0 Bleaw thde diadog box y o .
on Desktop) ’ﬁ L Welcome dialog box|
\\\ 2 e
= el #
i
I3 ::*-ﬂ-'
ot S e R R
i -

Qbasic Welcome W.fn'd_qw

Gomputer Science -



press Escape key to clear the Welcome Message box and the following window QBASIC

Menu Bar
'tdgpmysthe
command menus.

Status Bar
It displays the current AR
status of the program

file and some keyboard—[

. Type the program, as shown in the given picture.

r - m Micros ft i R T AR B
Title Ba oft QuickBASIC V4.5 5
e program.| |n—csv e ] (21 Totate]
jt displays the prog et dit_Uien Soarch Run Debug Calls Options H

sHicrosoft (R)IOUIEKBASIC H S0 (C TCéifFlTh!leﬁfﬁiEYffcﬁ‘li?ﬁfliﬁ?ETSISWJIEGTJL

1
< || Where we write

N

\

Program Mode

programs.

shortcuts.

QBasic Program Window

Immediate Mode
Where we can type
a single command
and run it to check
its output.

In QBasic, the interpreter executes the program line-by-line If it finds any error, it displays

an error message and stops the execution.

SAVING A PROGRAM

Click on the File menu and select Save As option. Give
a meaningful name to your program in the ‘File Name’ :
text box and press the Enter key. Your file will be saved
with the name given by you and extension .BAS will be
added to it automatically. The file name should not
exceed more than 8 characters.

RUNNING A PROGRAM

To see the output of a program you need to run the

program. There are many ways to run a program in
QBasic which are as follows:

" By pressing F5 key.

¥ By selecting Run menu and clicking on Start
option.

By typing RUN in the Immediate mode and

Pressing the Enter key.

E’““NG AND OPENING GBASIC . .
" To exit a QBasic window, click on File >

L)

Save As
File Name: IPranhant_ I
C:\QBY45
Dirs/Drives
Format
1 + (-) QuiekBRSIC =
[-c-] ] Fast Load and
[-E=] § Save
[-F-] §
[=G~] 8 () Text -
N Readable by
? Other Programe
[]3 < Cancel > < Help >

Save As Dialog Box

% Microsoft QuickBASIC V4.5
WELCOME TO THE WORLD OF BASIC PR

Press any key to continue

- sl

Output Screen

b For gdur IﬂgO‘

Exit.

To open an existing program, press Alt+F
€y. The File menu will open.

9

To start a new program, click on File
y menu and selec

b o i s e o o e 5 e




v Uyan Mapentas s l!lllCK‘E "
- £

om the EOTITILEY)

@ Highlight Open command [T . e A P ki
displayed options and press Enter. - Press key to sele;_t Al ms

® Select the program file from the | and Press N key to_ select IAIt +F
displayed list and press Enter key. - New P rogram Cptel '

CHARACTER SET OF BASIC . g

A character set is a set of symbols which are used in progamming language. Basic uses th

following symbols as its character set.

1: 2’ 3: 4: 5: 69 79 87 93 0
!a @: #9 $9 %s As &9 *s (:): \ Ty |9 ”s /a ?9 >7 <; .5 5e [s]: {:}9 etc.

CONSTANTS AND VARIABLES

Constants
The value which does not change during the execution of the program is called Constant

Constants are of two types :

Numeric Constants : Any numeri
is called a Numeric constant. For example : 224.+12, 0,
Numeric constants should not include any special character and are used for calculations.

Alphanumeric or String Constants : A set of characters is called a String. A

alphanumeric or string constant consists of a sequence of characters, A-Z, a-z, 0-9 an

certain special symbols like % ?2# 7~ ();: “/\ etc., enclosed in double quotes. Strin;

are used to represent non-numeric quantities such as names, addresses, etc. Fo
“RAGHAV”, “SUM = 847, “192” are a few valid string constants.

c value, an integer or a real number, positive or negativ
—7.4 are valid numeric constant

constants
example,

Variables
A variable is a location in memory to which any value can be assigned. It continues to hol

the value until another value is assigned to it. There are two types of variables :

Numeric Variable : A numeric variable can hold only numeric constant. It is represented b
an alphabet or an alphabet followed by another alphabet or a digit. It should not contain af
space or symbols like 7, 2,\, /, @, ;, : etc. Underscore can be used instead of space. [0
example, A, C, A2, ABC, A_ 6, etc. represent numeric variables.

Alphanumeric or String Variable : A string variable is represented by an alphabet followe!
by the dollar (§) sign. It can contain letters, digits, underscore symbol and the last charact”
is always a dollar ($) sign. For example, A1§ RKL$, COMPU1S, etc. are valid st
yariables. A string variable can also store string constant.

Tes].
3 u Bumn:&e:f:ll!linﬂ "n Am




Stri A1$. = Express
. (String Variable)

' The : _ (String Constant)
| ¢ length of a String variable can be maximum 40 characters.

pata in @Basic can be of one of the follo
@ String
String variable can hold textua] data
For example, “abracadabra”, “De[p’
® Integer

Integer variables can hold numeric integer data between —32768 and +32767
For example, 5, 10000, —34
® Long

igc;ngGI?riables can hold numeric integer data between —2, 147, 483, 648 and 2, 147,

For example, —1475, 1000
® Single-precision
Single-precision variables can hold floating-point numbers, i.e. numeric data with
decimal points.
For example, 3.14, 26.5, —05.
® Double precision
Double-precision variables can be used to hold larger floating-point numbers.
For example, 12345678.12345678, 6.023*10"(-23)

Naming Variables

Variable names can have a
combination of alphabets and

wing types :

. This is a text string, etc.

 Examples

String - ‘ $ 2 néme $, addrS$, strl$l

numbers. However, the last Integer % x%, age%, num 1%
character in a variable name 7y ., &  veryLargeNum&
can b ify its data ol - :

type :sléii)dv:g 151113 Etzl(itlef{aijlse. Single-precision number ! BELEE, GUAnHon
OPERATORS Double-precision number H electronMass#

There are three types of operators in QBasic.
Arithmetic Operators

A computer performs many ar
anithmetic operators. The basic arl

.thmetic operations and calculations with the help of
thmetic operators are given here :

T g o g s e L o "~,:-"." T ._:..‘.,'..2.

To subtract two or more numbers




2] [ i

* To multiply two or more numbers A*B 32
/ To divide two or more numbers A/B 2
A To calculate Exponentiation value A"3 512

Relational Operators . i .
They are used to compare two values using any of the given relationa Operatorg fro
relational expression :

Operator Explanation ~ Example |Result [Suppose A =10 apng;
E This operator is used to check the A=B Fiise
equality between two operands. :
. This operator checks the non-equality A<>B Prije
between two operands.
o This operator checks whether the first ASB True
value is greater than the second value.
o This operator checks whether the first A<B False
value is less than the second value.
—  This operator checks whether the first N
- value is greater than or equal to the a>=B True
second value.
. This operator checks whether the first
= valug is less than or equal to the second A <=B False

value.
Logical Operators
Logical operators are used to perform logical operations on numerical values. Log

operators are used to combine two or more relational expressions and return a single valu
TRUE or FALSE in a decision. The common logical operators are: AND, OR, NOT.

: 7l Example o
Operator Explanation o e Li, -B.‘: 15 and ¢ 20) _Res
AND This operator returns True only if both C>AandC>B 0
the relational expressions are True. A>CandB<A - Fals
OR This operator returns True only if atleast B>A orB > & Trut
one of the relational expressions is True. A =C of B=C Fals
This operator is used with single relational NOT A > C True
NOT €xpression. It returns True if the relational NOTB<C Fals

€Xpression returns False and vice versa.




Hierarchy of Operations

ierarchy defines the order in which the operators are ex ; _ _
i ecuted
use BEDMAS for the hierarchy of operation. The full form ofeB];ll)ijlig?; l'c e

B
B rackets @) M  Multiplication %
E  Exponentiation A A Addition +
D Division / S Subtraction I

@) For Your In,go

Basic is not s
a Case sensitive language. It means that ‘a’ and ‘A’ are same.

Solve the Expression :

12*4 + (14 +4) + 272 - 12/6 (First, bracket will be solved)

12*4+ 18 + 272 - 12/6 (Then, exponentiation will be performed)
12*4+ 18 +4 - 12/6 (Now, division will be performed)
12¥4+18+4 -2 (Then, multiplication will be performed)
48+18+4 -2 (Then, addition will be performed)
70-2 (Now, subtraction will be performed)

68 : - . This is the answer.

QBASIC STATEMENTS

REM

This statements is used to give remarks in a program. The computer does not execute this

statement since whatever is written after REM is ignored by. the computer. REM can be used
anywhere and many times in a program. It is a good practice to use REM statement at the

start of the program to explain what the program is all about.

M i i ' the Biodata of a student.
Write a QBasic program to display
10 R]?M 70 DISPLAY THE BIODATA OF A STUDENT

h ! 20 PRINT "ROLL e IIQEHAN KHANNA”
& &' | 30 PRINT “NAME ke
40 PRINT “CLASS :
50 END
tud i he screen. Any text written in double quotes is -
I . as a program component and its

{5 used to display any message of resu
Enlnted as such. Anything written withou

dlue will :
be displayed. e

tax :  [Line Number] PRIN .
[Line Number] PRINT < Variable

t quotes 18 treated

?
ne numbers are optional)

Name> (Ll
kl 71 i
. Computer Sclence S
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20 PRINT “Welcome to the World of Basic Programming.” :
It will display the message Welcome to the World of Basic Programming.

PRINT A _ ‘
It will display the value stored in the variable A.

PRINT .
It will leave a blank line.

End Statement

It is used to indicate the end of a program. Any statement written after END will

not
€

A. Tick (V) the right option.
1. The extension of QBasic program file is :

(a) QB [ | (b)Qbas L} (c).Bas || (d) None of these [
B i sign is added at the end of a String variable.

(@) $ [l & L1 @% []@e 1

3. Which is the correct nunieric expression?

(A)A="5*5" [ ] (b)A1$=52 [](@A2=21 [] (d)B2= g

rs

L

4. To hide the welcome dialog box, press ........ccoooueu.... key. - -
(a) Ctrl [ (b)Esc [] (@Al [] @Af+F ~ |
B csvennissnis key is used to switch from one mode to other in QBasic.
(a) F5 [ ] (b)F6 ] (c)F8 L (dF9 |

B. Fill in the blanks with the correct word.

String variable Quick Beginners All Purpose Symbolic Instruction Code
two BEDMAS Constant numericvalue character set

The flllll form ol QBasiCis e .
The value which does not change during the execution of the program is call

ol o

-------------------------

i Y enenissessasonts is a set of symbols which are used in programming language.
ThErE Ak umsoeasnss types of variables in QBasic.

3

4

5. Numeric constants contain only ..............

6. String constants must be enclosed within ..., .
7

The hierarchy in which the operators are executed in Basic expression is call

-------------------------

E _ Computer Science “-z
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te whether the followij
¢ St OWIng statements are true or false.

1.
2.

NS e W

QBasic s a very tough computer language -
A String variable is re ' { !
P presented by an alphabet followed by dollar (%) sign. ‘“ El

can be a maximum of 50 characters long, f
Constants are memory locations to store data in it
Numeric (;f:HStants include all the positive and negative numbers i
The variable name m fen -

ust begin with a number:; | |

Addition and subtraction operations come first in Basic hierarchy. r

Answer the following questions.

1.

What is QBasic? What are its fe :
. atures? Na < .
window. me the different components of the QBasic

Write the different ways to run a QBasic program.

.......................................................
--------------------------------------------------------------------------------------------------------------------------

Define variable. Name the types of variables.
What are the different types of constants. Differentiate Numeric and Alphanumeric
constants.
What are the types of operators in QBasic?
Deﬁn.;‘ the term Hierarchy of operations. Write the hierarchical order of the
arithmetic operators in QBasic. E
................................................... - -
What is PRINT statement. GIVe the exampl
i- 73 'I
compuler Science H
‘ Book-6




*#  Label the following picture.

e —

"’::&.:-T!?fﬂia

:- - —as it e g — T "
[ File Bdit Ulew Search Run Otbur ¢alle Options
Untitied

SBNTHR R AR R R NN S A S SRR e AN e

spurig

S

1. Find out the options present in the File, Edit, View and Run menu. Make separate listsf
all and write at least a line about each of them.

2. (a) To display a simple message “WISH YOU A GOOD DAY”.

(b) To print the entrance form with the titles as : Name, Age, Father’s name, Occupatie
Address and Contact number.

(c) To display thought for the day :
“Success is a MARATHON, it’s not a SPRINT”

Computer Science . '
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. assignment Stafement—LET < GOTO Statement  « IF..THEN...ELSE Statement

¥ bRINT Command % IF... THEN o T3
© NPUT Statement & Blimps Prjfc’femenf # Using ELSE...F with IF...THEN Statement
CONTROL Statement SHams < Repetition Construct

———

As with ordinary languages such as English, French, etc i
: : ’ , etc. programming languages also have
Ithelgrusa%zcafsic nl::rywe ;)tl;ilgt ai’ll‘(il lssyrlxtalg In fact, the application of these ru%es 1_;:51:1 Srogramming
i : 8 because a program has to be explicit, as it is a preci

. - ] se
statement of the actions to be taken. QBasic also has its own keywox%s and syntax. g

ASSIGNMENT STATEMENT—LET
The LET -staten_lent or Assignment statement is used to assign a value to a variable. In
QBasic, 1t 1S optional to use LET statement and line numbers.

Syntax : [Line No] [Let] < Variable Name > = < Value or Expression>

LETA=5

LET A=5
It will assign the value 5 to A. B="15
Sum=A+B C=A"B
It will add the value of A and B assign the result to variable Sum. EEQ‘T ¢
Let A$= “QBasic program”
This statement will assign the value “QBasic Program” to the string variable ‘AS$’.
PRINT COMMAND
The PRINT command is used to display numbers, messages or values of variables on the
output screen.
Syntax : [Line No] PRINT <Constant> or <“String Constant™ or <Variable> or
<Expression>
BIEEME  prINT 20 + 10
_ £20 and 10.

E :

o
w

|
|

i Y It will display 30, the sum O
J

PRINT “GOD BLESS YOU™
! i iable A
It will display the current valu;: of variable A.
i 'Iirci‘jT}ie)y ?ﬁgexﬁjs?algse: ‘:Th.e Value of A is . followed by the value of variable
will displa
A. '
rent variations t0 print

Th, camer
¢PRINT command can be used 10 diffe

the output in different forms.
r-n-—‘

4 | computer Science
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Print with Semi-colon (;) _
: : . fler r, without
f PRINT with semi-colon is used to display the values one after anothe any SPagg

between. TR
ax : [Line No] PRINT (Variable); (Variable); (Variable);...
s 1 Microsoft QuickBASIC V4.5 \'\

LET X§ = “MY NAME”

MY NAMEISRIA

EXEMBIE .
LETYS$ = “IS” MY NAME IS RIA
LET Z$ = “RIA”
PRINT X8: “*": ¥8: “ " Z3
END

Press any key to continue '

Print with Comma (,)

It is used to display the values one after another ek I
7 ror Your HgO‘
df

with plenty of spaces in between. Only five values
can be printed in one line. In case of more than five
values, the remaining values will be printed on the @
|

i

next line.
Syntax : [Line No] PRINT (Variable), (Variable),...

‘B In QBasic, whenever any iten
enclosed in the square brackets (]
meansitisoptional.

Entlaple LETX =178
' LETY =22
Z=X+Y
PRINT X, Y, “SUM?”, Z
END

Press any key to continue

Print with Tab Function
The TAB function is used to move the print position to the column indicated in jt argume
This statement is quite suitable for printing tabular type of results. PRINT TAB statem

can be used in controlling column location.
Syntax : PRINT TAB (C); “Constant/Variable/Expression”

Ekmpl(: Where C is the column number
PRINT TAB (18); “GOODEVENING”

In the above example, the message
column onwards on the screen.

Info

CLS command is used to clear the output screen. It is usually written before starting
program, so that the output of the previous programis not shown on the screen.

“GOODEVENING” will be printed from the 18

Computer Science
Book-4




REM “TAB FUNCTIO

N PROGRAM” [ mMicrosoft QuickeASIc VA 5 bty
E;R/[TI’{I‘K'I;%B (10), “NAME”; TAB (20), NAME ::M:S. . .

PRINT TAB (10); “MANAS™ Tap (o) 02

; TAB (20); 90
PRINT TAB (10); “KABIR"; TAB (20); 97
giIDNT TAB (10); “RIDHIMA™ TAR (20): 98

Press any key to continue

The INPUT—{; istattement n QBasic is used to accept the data item from the user and store it in a

ment asks the user to make data entry by displaying a question mark (?)

Juring the execution of program. The Program execution is suspended till the user enters the
required values and presses the Enter key.

syntax : [LINE NOJ INPUT <Numeric or Strin

<[ g Variable Name>
[[&{:Jmplg 10 INPUT A

r“'.:“

‘ﬁ? For Uour I"'&T

"B Thevaluesto variables are assigned according to their type—Numeric or String.

—

___________________________ A

You can have a list of variables in an INPUT statement but they should be separated by
commas.

Syntax : [LINE NO] INPUT '<Variable1>, <Variable2>, <Variable3>
The corresponding values which you key in should also be separated by commas.

{ ‘g\.\

gupldl  REM PROGRAM TO ACCEPT VALUES
, INPUT NAME$

' INPUT CLASS

INPUT SCHOOLS

PRINT NAMES, CLASS, SCHOOL$
END

While using INPUT statement, the computer does the following things :
It stops further processing of the program.
It prints 4 question mark on the screen. ;
It waitg for the user to key in its response and press the Enter key. | '
! stores or assigns the same data item into the corresponding variable mentioned in the
T statement. T - =
fre ‘an further modify the INPUT statement by providing an optical message, separating it
0 s K-
ym the variable using semi-colon (;) "
"X INPUT “MESSAGE”, <VARIABLE> | e

l 77 |
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INPUT “MATHS”; M

INPUT “COMPUTER:”; C
INPUT “ENGLISH:”; E

INPUT “SCIENCE:”; S

INPUT “HINDI:”; H

INPUT “TOTAL MARKS:”; TM
SUM=M+C+E+8S+H
PER = (SUM/TM)*100

PRINT “SUM ="; SUM

PRINT “PERCENTAGE”
MARKS="; PER

END

Note that the punctuation between the message and the variable is a semi-colon. T
message and the variable name together represent one data item. You can also give INP{
statement in the following way:.

Syntax : [LINE NO]J INPUT “MESSAGE”, <VARIABLE!>, “MESSAGE”; <VARIABLE)

CONTROL STATEMENT

While executing programs, sometimes it becomes essential to change the order of execut
of some statements or to repeat a particular set of statements subjected to a given conditi
These kinds of conditions require logical decisions. The statements that help to control |
flow of a program are known as Control Statements. There are various control statements
QBasic like IF-THEN, GOTO, IF-THEN-ELSE, etc. for performing conditional checks ¢
repetitive actions.

GOTO STATEMENT it
In a QBasic program, GOTO statement is used to transfer the program control from c
statement to another. PR L

Syntax [Line No.] GOTO <Line No.>

10 A=1

20 B=A*A

30 PRINTB

40 A=A+1
50 GOTO 20
60 END

Press any key to continue

While executing this program, control will shift back to Line no. 20 each time it exect
Line no. 50. The program will never stop. It is called Infinite Loop.

In our daily life, we make decisions and take actions accordingly. _
Example : Our plan to go to a movie will depend upon the avallablllty of tlckets

Condition Plan of Action .
1. Iftickets are available See the movie..
2. It tickets are not available Have food in a’-_restaundﬁt:- BT

8\
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gimilarly, the computer also deci : _
validity of condition. Every decision i _Cﬂdeependmg upon the validity or non-
7. .THEN STATEMENT ¢ between the “Yes’ and “No’ result.

This statement is used for making decis; s

ons based on ;
S}'Btax : IF <CONDITION> THEN <ST ATEMENT>C0mpanSOHS'
If the condition 1s TRUE, then the ip :

condition is FALSE, the control shifys t

0 the next statement.
m IFX>YTHENC=C+1
iy It means that if X ig greater than Y, then

oo
=N IF A$ = “Class X THEN INPUT
| The value of variable NS, A, M will
= equal to “Class IX”.

IF C> 10 THEN PRINT C

The value of C will be printed only if the value of C is greater then 10.
40 IF C =10 THEN GOTO 80

IEC ig equal to 10, then control will be transferred to the line number 80,
otherwise the next statement will be executed.

g@ For Your IH&O‘

‘fi The condition in IF-THEN-ELSE statement is given by the
SIMPLE PROGRAMS » Telational operators: >>=,< <= =and <>,

I

‘THEN’ is executed. If the

1 1s added to the value of C.
“NAME, AGE, MARKS”: N$, A, M
be input, only if the value of variable A$ is

- Write a program to compare two numbers.

REM PROGRAM TO FIND THE GREATER NUMBER

CLS

INPUT “ENTER TWO NUMBERS:”; N1, N2 ’

[F N1 > N2 THEN PRINT “GREATER NUMBER I’S’ PN

IF N1 < 2 THEN PRINT “GREATER NUMBER IS;”; N2 i
IF NI = N2 THEN PRINT “BOTH NUMBERS ARE EQUAL

END
For Uour Iﬁ& “

Wh I[F-THEN statement is encountered, the computer first evaluates relational
en an [F-

¥ expression and then detennines”\__?j/hefb?r___i_t. ]S TRUE Or_FALSE‘_

~— ltmsmcmsmocmmmcmamsmsmsmesEmETIIT I
. Clear the screen.

: Input two numbers.

Step3 Check whether the first nl;)nﬂr |
g number as the greater nc:ln"; :u}11 ber is a greater than the first. If yes, thn print second
. Check whether the s€C :

number as the greater number-

' . If yes,
Step 5 . umbers are equa

: both the n i
S Check whether

*8: End the program. R =T

ber is greater than the second. If yes, then print first

then print both numbers are equal.




WO pumbers, dcpcndinql

. e Y L"i‘l & l
Write & program to find the sum ot differenct PQM
choice.
|
10 CLS b i |
(RERS™: A B G TRTRACT .
20 INPUT “TWO NUM{?I:\[EDITI 5N, 2 FOR SUBTRACTION:™;

30 INPUT “Enter \
40IF CH=1THENC=A" B
50 IF CH =2 THEN C=A-

60 PRINT C
20 INPUT “DO YOU WANT T
80 IF QS = “N" THEN GOTO 20

0END gt

’ Step 1: Clear the screen.

J' Step 2 : Input two numbers: A and B. _
| Step 3 : Enter your choice, either 1 for Addition or 2 for
‘ Step 4 : If CH = 1, numbers will be added and the resu
Step 5: If CH = 2, second number will be subtracted from
Step 6 : Print C.

Step 7 : Press Y’ to exit and ‘No’ to repeat the process.

Step 8 : If user types ‘N', then control moves back to line number 20 and the progy

- repeated.
Step 9 : When a user enters “Y", the control moves forward and the program ends.

0 EXIT (\"/N):":Qb

gubtraction in the variable CH

It will be stored in C.
first and the result will be Storeg,

—

IF...THEN...ELSE STATEMENT
making statement. If the condition given afler]

[F-THEN-ELSE is a conditional decision
True, statement(s) specified after THEN is executed. But if the condition 1s False, the !

statement will be processed.
Syntax : IF <condition>T HEN <statement1> ELSE <statement2>

To print odd numbers between 1 and 100.

BEsmad 10N=1
N 20 IF N < 100 THEN GOTO 30 ELSE GOTO 60

30 PRINTN

40N=N+2

50 GOTO 20

60 END

lay whether a person is adult or not.

10 CLS
20 INPUT “ENTER YOUR NAME AND AGE™

30 IF AGE <18 THEN GOTO 40 ELSE Gorgy ag > "
40 PRINT “HI”; NAMS “YOU ARE NOT AN ADULT"

50 GOTO 70 GLT

60 PRINT “HI”; NA.MS uYOU A_RE -

70 END ANADULT

| gy |
(L80]
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ysING ELSE-

E sta
LS IF

JF WITH IF...THEN STATEMENT

<Condition 1> THEN

Syntax ' <Action 1>
ELSEIF <Condition 2> THEN
<Action 2>
ELSEIF <Condition 3> THEN
<Action 3>

ELSE
<Alternative Condition>

ENDIF

1o Print the divi
Jample

To calculate dis

sion of a student, based on the marks scored.

INPUT “ENTER MARKS PERCENTAGE”; MP%
[F MP% >= 60 THEN

PRINT “FIRST DIVISION”
ELSEIF MP% >= 50 THEN
PRINT “SECOND DIVISION”
ELSEIF MP% >= 40 THEN
PRINT “THIRD DIVISION”
ELSE

PRINT “FAIL”

ENDIF

END

count on the basis of Bill Amount.

CLS )
INPUT “Enter Bill Amount™; AMT

IF AMT <= 2500 THEN
DISCOUNT = 0
ELSEIF AMT > 2

DISCOUNT =02 & 5
£ SEIF AMT > 5000 AND AMT <=
DISCOUNT =0-3

ELSE T
DISCOUNT =04 AM

END IF "I .

NET = .
PRINT «The Bill Amount 15°

END
aamnutan Selence

1S use i
rement is used when we want more choices in the IF... THEN statement



REPETITION CONSTRUCT s T oxeciited s chrt,
1t i f statements 1O _ >rtain |
Repetitive constructs allow a specified group of N <otements is known ag |00m|hk._
ol p ns to repeat SOI]]cthingplnE

£

of times. This repeated execution of a group -qtion mca
Every repetition of a Loop is known & ]fl'ﬁl-atl(;::;;I;fa[t?;nwnts . FOR...NEXT and D¢ > %
two types of loop '

and over again. QBasic offers

FOR... NEXT LOOP ‘ v tifies
It is generally used as a counter loop when you know exactly how many Umes yoy ne@dh
“execute the loop.
Syntax: FOR Evariable> = <initial value> TO <final values=
<Statements to be executed>
NEXT <variable>
Example 1 : CLS
ForI=1to5
PRINT “Hello World”
Next | N _
alue. The initial value 1s 1 and the i

In the example, I is a variable which will store a v : ‘
11 hold a value of 1. The prograim prints Hello Wy,

value is 5. To start with the variable I wi : , .
and moves onto the NEXT I statement and checks if the variable I'is 5.
If it is not 5 then the program will continue and jump back to the FOR commg

increasing the value of I by 1. It loops until the variable I is 5, printing the text Hello Woy

five times.
[ &8 Microsoft QuICkBASIC V4.5 ‘ol Y

| = Microsoft Quitk_MlC V4.5 ik . J
[ it Uiew Search Run : Y e B et

Press any key to continue

Example 2 : CLS
FORI=1to5

PRINT I
NEXT I
The above program prints the numbers from 1 to 5.

=y |
i 82 >
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= eI VA e I .o ‘
ucltﬂ'“s - pun Debug Calls Options m M ? Leairm ——h
Q o ch = Untitled —.£ = : - jerosoft QuickBASIC VA5 | o

Press any key to continue

The STEP command can be used with the FOR..NEXT loop to counter the increment by the
8 jesired number. For example, FOR L =1to 5 STEP 2 will increment the value of [ by 2in each

et A
po LOOP
Itis a block of commands where the program does not have to loop a certain number of
imes like in FOR...NEXT loop. It can loop indefinitely. e

The DO LOOP has two forms in QBasic. DO WHILE...LOOP and DO UNTIL...LOOP.

D0 WHILE...LOOP

The loop executes until the condition becomes false.

The syntax is : DO WHILE <conditions>
<statements>
LOOP . i

Through this loop, a condition is evaluated. If the condition is false, it jumps to the first
statement after the loop. Otherwise. it- executes the statements inside the loop and then goes

back to step one. :

Example -
“File  Edit
COUNT # 1

B[O WHILE COUNT 4
pIinT COUNI
COUNT < COUNT 4 I
LOON




et
o
ft QuickBASIC V4.5 ]
"".l:;

@y Microso

Here, the loop is executed while the value of the
count is less then or equal to 10. Once the condition
ated. The above program

is met, the loop is termin
11 to 10.

prints the numbers fron
a True loop. It works till the

This is also known as
condition given does not become false.

fy Ly L T R

~i

L+ K- -4

Pross any key to continue

DO UNTIL...LOOP
The loop executes until the condition becomes true.

The syntax is : DO UNTIL <condition>
<statement>
LOOP

If the _condjtion is false, QBasic €
condition is true. If the condition is true,

remainder of the program.
Example :
TR R BE =]

I'I_E-'l_ig‘r_osol‘tgu}ckBASIC V4.5
File FEdit Uiew Search !

nd continues to do so upf

xecutes the statement a
past the loop and execute

QBasic jumps

PRINT X =
rm e b

LOOPUNTIL X = 1

Here, ?he loop is executed while the value of the (- :
count is not more than 10. Once the condition is MietenQlicaASICyA >

met, the loop is terminated. The
' _ ; ab
prints the numbers from 1 to 9. ki
This is also known as a Fal

Is : se loop. It wo I
the condition given does not becorlxj'le falserks il

” 84 i»
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g2Jo0st R%ur ©rain

.-

- rick ) the right option.

(. The e statement in QBasic is used t ' i
@) s L1 () Input to nc(crf.)plt ft!}ro data item from the user.
9, e .command helps to insert commL_] ok et ) —
ogram Ty ents that enable us to understand what the
(a) LET . (D) REM (¢) CLS (d) IF
; e Eots i
3. (]Pt statemen__l__c_han be used in controlling column location batfE h—_J
2) Prin (1 (b) Tab — o Beine ol -
4. InBasic, whenever any item is enclosed inLt—h_ej o e e
e 1t MEANS it is optional.
(a) Curly brackets | ’
b) S
(c) Rounded brackets : Ed% L?nu:;i:cf;}fts o
~Ree— statem ’ ' nt.
5 entis used when we want more choices in the [F.. THEN statement.
(a) ELSEIF || (b)GOTO ]
(c) IF.THEN..ELSE . || (d) none of these f
B coeassessibisiniiis statement is used to transfer the program control from one statement o
another.
(a) PRINT . (b) IFTHEN __ (0 GOTO __ (d)CLS

B. Fill in the blanks with the correct word.
THEN LET IF-THEN-ELSE FOR-NEXT comparisons Control decisions

(R 1 /. N— statement or Assignment statement is used to assign a value to a variable.

7 S —— statements help to control the flow of program.

3. |F-THEN statementis used for maKing ... BASBA OB v
is conditional decision making statement.

A

5 If the condition specified after IF is true, then the instruction after ... Is
executed.

6. 4 loop is genem”}/ used as a counter loop when you know exactly how

ed to execute the loop.
tements are true or false.

of results. |
output on the screen. L_, &

L

ed to each

many times you ne
(. State whether the following sta
1. TAB statement prints Tabular type

2. The PRINT statement PrUVides «frari
3. CLS command clears all the co?w“ts of the mu"". . get clos
4. When comma is used with PRINT statement, the iems get clos

other leaving no space: wp symbol s displayed? C J
I
g

ations to print the

xecﬁted the

5. When INPUT statement is X255 bl
% X0 h ly one INPU'I‘Stthcment in a program.

u can have only =

P | - gomputer Sclence H L——‘



D. Name the st ; and
atement/command.
/ es into the computer’s memory at Tuntip,,

The statement allows us to ente

The statement is used to give values to d varl
ay the output on t

1t line in your program.

rvalu
able.
he screen.

The command is used to put a commel

1

2

3. The statement is used to displ
4

5. The command is used as counter [00p.

E. Answer the following questions. do wh

1. What is the use of INPUT statement? What does a computer SV, Iy
statement?

2. Differentiate the use of PRINT statement with comma and semi-colon by U
examples.

3. Define the conditional statement IF-THEN-ELSE.

4. What is the use of GOTO statement? Explain with example.

5. What isiloopin g? Describe the types of looping with examples.

6. What are the differences between a True loop and a False loop?

Write the output for the following statements.
(c) Print “10 +5"

(a) Print9*3+3 (b) Print “Hello”; “India”
(d) Print12*3+4 (e) Print “I”; “Love”;"QBasic” (F) Print “2 +4"

To display a sample message “Have a good day”,
To calculate the square and cube of any number. -
To display the following result: Hello, (your name). How are you?

To display even numbers between 10 and 60.
To print smaller of the two numbers entered by the user.

1.

2,
3.
4.
S
6.
7.

To display odd numbers between 31 and 60.

To check a person is eligible to vote.
To print the multiplication table of a number,

Computer Science
Book-6. _
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. Lesson Extract

' sﬂ;ﬁing Flash .
" components of a Flash Window

. working in Flash

. Using the Tools Panel
T The Selection Tools

< The Coloring Tools
< Text Tool

< Creating a New Flash Document

)

» Using Frame by Frame Technique to Animate

Macromedia Flash is a software that enables the user to make interactive animations. It is a

sser-friendly software that qoes not require any special programming skills to work on. You
can create MOVIes nad motion pictures with Flash. Flash files can also be embedded into a

website to make it interactive.

Flash originated with the application of SmartSketch, developed by
jonathan Gay. Flash was originally owned by Marcomedia. Presently it is
developed and distributed by Adobe and is popularly known as Adobe

Flash.

Nowadays, Flash is used for making advertisements and games also.
There are various Websites available where flash games are available free
to play online and download. Some of these sites are :

¥ www.novelgames.com
¥ www.flash-game.net

STARTING FLASH

Flash are -
)

The various steps to start Macromedia

l

* Programs.
0.

. Macromedia. -

Open it,

The following window will appear.

Click on Start button to select.
From the sub-menu, ~select

Click on Marcomedia Flash 8-t0

Jonathan Gay
) For Your IHEO‘

Jonathan Gay was the co-founder of Future
+ Wave Software in 1993. For a decade, he was
E the main programmer and visionary of Flash.
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ﬁn Aooe Fie (31 Profersonk ;

(ored

RO £ SUONAL

ADOST" HLASH' CSTF

R T

COMPONENTS OF A

On clicking the File menu and selecting Ne
before you. The following are

FLASH WINDOW

the components

w opti

on, a Macromedia Flash window g
of a Flash window.

i Title|

~=Timeling

Nnfol

Work Aréi

Menu bar ﬂwhncs: Breturional « (Untted-3]
el Fie fO1 Vwn bupt Mealy Tea Commancd Contet Denug Wndow VEF
r.ﬂ! 1 (L i 4
LR d
LN | LY
o T \
5 Layers Panel e
T ‘ e - o
ool e £3 &
palette 44 PRI PSP R T WO oo K
ra s Aseel Werkspace® 0, &, T2
ra -  PEALLE
€y -
S A
5 SR
L
m
Stage |urttas ) v
Ermpry drary
T ———
Hame Tyse »
- o
' :
Properw ._laa'-iu;a Bacigennd Frama ren: 12 tou &
Inspector Lot  j twde o daeitonr 08 o Deak
Window = Dotumrant Ents: Y (]
Quo § ¢ . !

Title Bar and Menu Bar : The Title bar di
bar gives you access to all the commands al;,sg illaa }l;slc:lii Ié?me of the open document an

complete any task.

Bl

Gomputer Science
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B UBET 3]

jotte * vou can choose different tools available in Tool Palette to create and modify

1'0.[]] Eﬂ raphics.
lg},gﬂ e ThiS'IS tl_1e rectangular area where graphics, text and video clips are drawn or
r[hf:?1 nd animation 18 created.

a .
ghce cea : It refers to the light grey area around the Stage. You can place objects here
x‘i’f[fk u want them to appear on the Stage.

[l 1 . - ) * . . . . .
y er [nspector Window : It helps in organizging and modifying the various properties
proP olected objects.

O‘nleliﬂe panel : It organizes anq controls a document’s content in layers and framcs. Like
Ellnlss Flash documents divide time-length into frames. The timing of an animation is
ed in timeline panel. Thus, it helps in setting the sequence of a movie or animation.
panel : It helps to manage t.he layers. Layers are like multiple film strips stacked on

ne other, each containing a different image that appears on the Stage.

There are 9ther palettes available. They provide the essential information and control over
1 animation process. They can be arranged in stacks and moved around the screen and
llapsed to icon VIEW.

{ORKING IN FLASH

Flash environment is very easy to understand and use. Let’s learn to work with the Flash

environment. '

create a New Flash Document  [BESFRRERERETEE PR = e et

The various steps to create a Flash e

document are :

0 Click on the File menu to select
New option. A New Document
dialog box appears. B roi

o Select Flash Document option in | | [ s
the Type list. Bl

® Click the OK button to open a |gms
new document. 3)

Ablack Flash Document is created.

IifUW you can give it a name and save [

Tupe Descphen

Creatn B e Fash dotrest = Fa' = the Fizt

Brrumert wondno The Fubeas Sammgs o o e Bet foe
AhehSErg? 1 0 USw Fineh dotiemeety [ paf up the My

e pruttied for Firsh Mo e and Bpzoatons L

T Fivsh Fda Dable’
1 Fash Sude Fresertstaon

S e
ave a Flash Document R L
Itls N . ki L Acone Frasn £53 rotessionat 0
= gODd ldea to save a new document When YOL‘I Stﬂl’t WOr. lllg F_-F] kot Commanats Comvol Window

MNew CrrisN

W .
ith 1t so that you don’t lose any ofyour document. [ o Cri-0 |

Bowse CireAn=0

®Various steps to save a Flash document are  oentiomsie.
Click on the File menu and select the Save option. | °" “'
Inthe Save As dialog box, specify the name of the file: flash iy
eX?ﬂd click on Save. The Flash Document files have an 0
ension of “ fla”. L T |
. | 39 s
; ' | Computer Sclence H
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. g~ B

file must beé converted to Flagh g
ay,&

a5 Mimel Feeder s
; - ilable on the Web the “fla™

\) To make the content ava
files having an extension of “ swf”.

saved Flash d
option. Choose the file from the Cp

USING THE TOOLS PANEL
Now, that you have an idea 0

y click on (he File menu and Selecto

d click Open- b

ocument, simpl

To open an already .
en dialog box an

thods of working, yoy .
d

its basic mety ;
tion can be applied. n,
ut, .

f Flash interface and _
which anima

the tools available in Flash to create a figure on :
create a new flash document and use the different tools learnt. :
creating and modify;

There are various tools in the Tool panel of Flash that help 1n o tools which hely

objects of animations. These tools can be categorised 5 draw1
drawing objects and Selection tools that help you 1D selecting

Let’s learn to use some drawing tools here.

the objects to be moﬁ?}“

his tool has an option which

rled
Detug - Windaw  Hem

This tool is used to create square an
be set to drawing rounded rectangle. A G Rotesent UV oo Deo

® Seclect the Rectangle Tool. I - S
@ Select the properties for the Stroke | _

color, Stroke style and Stroke
height  from the Property |,
= \E:actangie fﬂ:OT y mc B X

Inspector.
@ Sclect the Fill Color Tool and ;? E gsenet

choose and color of your choice. | il Color
Hold and drag the mouse pointer | » i
on the Stage. As the rectangular i i
shape is created, release the left 1 8
mouse button. i HCHE Emu s
® To draw the rounded rectangle, :
specify rounded corners by
clicking the Round Rectangle
modifier and typing a corner radius
value in the Property Inspector.
Now, draw a rectangle on the
Stage. You will get 2 rounded
rectangle with the specified corner
ra /E%ﬁ;\ g =

settings. ‘
i O {38 7

For Your I@ j
T Y i Using the Rectangle Tool
oopen afile, selectFile ~Upen option. Choos i 3
etherequired file and click on Open b“twﬂ",x

-—-.----.----—..-_—_--.----.____ PR
- e e e
T T p—— -
l-—-—...-..----.-.-.-.—

Computer Sclence
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Rectangle Tool
d rectangular shapes:

¢ rafps @0s G

(0
8
[3)

anan(l

| |

B [=m= e [T EE I
‘."Propem*]
-+ 4H! Inspector |

e

{—— L . ______..3_'
& . | ot |

[ S P ——
(Stroke Color, . J

3 Remrie 3 1
e e e el oy
~ {Round Rectangle modifier

TEa
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B
the small triangle at the lower
L Cf:'e hidden tools. .
. t can also draw other shapes like Oval, Pol

& Yﬁ: small arrow on the Rectangle Tool
t

right corner of the tool icons, to view

ystar, etc. on the stage by clicking
and choosing the desired tool from the drop-

rmm———
-

JyStar Too!

e ool is used to draw polygon and star figures. | i é‘ |

¢ Thlst the drop-down menu of the Rectangle Tool. It will 7 v[Qd) Rectangis Tool (R)

' ?slefay a fly-out menu. | 5 ovalTesl (0)

y S\[ell;ct the PolyStar Tool. | . = j: e
o the Properties Inspector,. click the Options button. You

' will get the Tool Settings dialog box. Click the drop-down

list of Style option and select the Star style.
) Enter the number of sides. Enter the value from 3 to 32 for number of sides.

 For star point size, enter the number between 0 and 1 to specify the depth of the star
points. A number closer to 0 creates deeper points.

Gk OK to close the (@i s s
T(]Ol Settings dlalog S Wew liet Medfy Iaet Lemma

box.

Click and drag the ||sr _ Jros

. N O - 2 &
pomter On the Stage to = FESTOR | Sip o W[ 1 B2Afpr BAe 4o L] : i :‘: T

draw a star, o 4 .

P LY ¢ Workspazer ¥, 49, [0 : .
Similarly,  you can |[%3
" a2 polygon by ||2
lecting Polygon
EI;EOH in the Style text

Lo I ol
. v A A1 y H{
DB s Foxe

M O oy Tin
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The Line Tool works cxactly the samc way as the line

Line tool to draw straight lincs. :

@' Click the Line Tool. e oy peym e e e B SE T

@ In the Property Inspector panel, F{}TZZ’TE&TF@ ' ..\\
select the colour, thickness or line |7 ‘ s

style as needed from the order of
events in sequence.

@' Move the pointer on the Stage.

® Click and drag it in the direction
where you want to draw a line.

@ Release the mouse button. You will F&8
get a line on the stage. | &

‘;) For Uour Ingo*

. Press the Shift key while dragging to
* draw a straight horizontal, vertical or

,"_ ded T S e Wrnpees + A o
v o I & e ) g %
Y Start point [
s m .
' ,;.

End point

| diagonalline.
(D sl P e aeien e e _\
You can turn a straight line into a curve with the Selection Tool.
(Make sure the line is not selected),

® After drawing a line, click the Selection Tool.
r changes to arrow with curve symbol

@ Move the pointer on the line. When the pointe

and drag the line to draw a curve.
@ Release the mouse button when the curve is made.

This tool is used to draw precise paths as straight | A A c A

lines or smooth flowing curves. We can also adjust \ /

the angle and length of the straight segments and the \

slope of curve segments afterwards.
B B

@ Select Pen Tool.
e, 1
Click on the Stage to define the anchor A. Using the Pen Tool

@ Click to create the second anchor Point B at a distance.
To complete an open path, double-click the last point or click the Pen Too

Tools panel.
& To close a path, position the Pen Tool over the first anchor point. A small
e thel

appears next to the pen tip when it is placed correctly. Click or drag to clos
Flash automatically fills the path once it becomes a c);osed outline. - 3

~ Computer $cience
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To Close a Path

L —" Open Path

' 001
,rnalf;eehand drawing tool. This tool helps to draw lines in three different modes :
s ?ﬁeﬂs gmooth and Ink.
_trﬂlglect e Pencil Tool.
- ¢ a stroke color, line weight and style from the Property b
v E] Straignten

| fsi;icwr panel and draw lines. |
ten : The default option is Straighten. Straighten mode m .
%

(3) Straigh- ) ;
_autgmaucally straightens the line drawn by the Pencil Tool.

smooth : Smooth mode smoothens the jerks on the edges. Ink

!
1

(0) )
(© Ink: Ink mode helps in freehand drawing with no modification ]
applied.
/‘\ —
( \ |l
i A
Straighten Smooth Ink

Three Modes of Pencil Tool

:HE SELECTION TOOLS
tlection Tool
};211001 i_S used to select a single or multiple objects 0
: Te"t different properties of an object.
') TO Select a Stroke fill, text block or group, select this tool and click on the object.
) “? Select a filled shape and its stroked outline, double-click the fill.

arzu?&l select the filled shape and its outline either by dragging a square selection box

the object or by double-clicking the fill.

n the stage. There are different ways

Computer Science

P |




=

All the other text properties that you fi \
hers arcavailablel

%? For Uour IHgO‘

+ color, font size, alignment andol
b e e o o B 7 o

nd in a Word processing software likq .
# - Oﬂl
n Flash. |

- ——
—~—

Lasso Tool )
can use this tool to select irregular shapeq are,
\)

This is a freehand selection tool. We _
drawing or a part of an object. This tool has 3 options.

Click the Lasso Tool.
Move the pointer over the Stage a
Click and drag the Lasso around the object un

Release the mouse button.

Subselection Tool
This tool is used to select the nodes of an object.

After selecting this tool, click on an object and |3}
its nodes will appear. 75
You can change an object’s shape using the || /m

nodes. >

o
i’ )

n, *Subselection Tool'
N\ O,
7 7
RN |

s ol Bl

 owmoo %W [ 1 120fpe 0ds |10

A
/R

rea. It changes to Lasso shape.
ti] we reach the point where we Star

sso Tool |

FEATR | o W i b Mol fee .

VS ¥ Srene 1

Lasso Shape | §

L rees e | B | Teenen |
|-fT ] to | wmeampas | museed L ae
it ) L7 Femngs U R T

Eotwgpat fiian

s
L 1 n;__'

>4

: Using the Subselection Tool
THE COLORING TOOLS

Brush Tool

It can be used just like a brush on a canvas. You can
paint a shape with the desired color using the Brush
Tool. You can specify the brush mode, by sclecting a
brush size and shape using the brush tool modifiers
Some of the options that are available with Brush Tooi
are as follows:

. L?f—l‘ Computer Sclence .'_"

Poanleibh

Using the Lasso Tool

) For UYour IH& L

Lasso Tool has three 0

] -*\

Magic Wand

Magic Wal.‘ld Settings

¥

%




g Paint OVer lines and fills.
1 ‘ .
Fantunrma o Fills empty areas leaving lines unaffected.

= Pal
> Applies a new fill to the selection.

6 de
g E/0: QuickKey)
The shortcut of the Brush Tool

The shortcut of the Rectangle Tool

ints blank areas of the Stage leaving lines and fills unaffected.

= Paints only the fills and doesn’t allow you to paint outside the lines.

B
N

R

The shortcut of the Line Tool
| ve o

Paint Fills Paint Behind Paint Selection Paint Inside

gt Brush Mode Modifiers

nint Bucket Tool

his tool 1 useful to fi
Jso use the Paint Bucket
qvides modifiers to close gaps in shape outline.

Tnﬁll color in an object, follow these steps :

) Select the Paint Bucket Tool. PP
¥ Click the Fill Color drop-down arrow. The color palette appears. ¥ o
¥ Select any color of your choice and click inside the object. :
I 0‘ )
Q Don't Close Gaps :
wt_ij --Close'S'mhl Gaps ®
Q) Close Medum Gaps e
W Close Large Gaps
Brush
size

Ing Using Paint Bucket Tool
1 Mle Togy

Sug :
"o change the stroke color, width and style of lines or shape outlines.

s> ‘ .~ _Computer Sclence
. BmAbdA

1l enclosed areas of an object with colors in a single click. You can
tool to fill the areas that are not completely closed. It also

‘ -

1
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) Select the Ink Bottle Tool.

“ Choose the Stroke color, style and
thickness of lines or shape outline from the
Property Inspector.

@ Click on the line of the drawn object using

the Ink Bottle Tool to apply a different Using Ink Bottle Tool
property to the stroke.
Eraser Tool r‘@) ‘auickKey)
This tool helps you to erase lines and fills of an object The shortcut key for
from the Stage. Ink Bottle tool is
@ Select the Eraser Tool. The shortcut key for

K

@ Click on the Eraser Mode Modlﬁer and select the  paint Bucket tool is
required eraser.

R &"E‘_“"’“ . Faucet Modifier

*a0)
|

e i '

LT /

N Eraser Mode ‘ v . Erase Normal
|

P
XA CARTE | Powoz W (L) llohs By 4

f FavE 1S # Seme | Wk

Eraser Toc_.aql O Erase Fills

(B .

| ;f _ < Erase Lines

ik ° Chck here for Erase|
« shape Modifer ©. FErase Selected F
-®

g -

[ e © Erase Inside

8 Fm a

) Eraser Mode Modifiers
Using Eraser Tool

@ Click on the Eraser Shape Modifier and select the eraser shape and size.

@ Click and drag it on the object to erase. eloauickiKey)

The different eraser mode modifiers are as follows : The shortcut of

Erase Normal : Eraser all lines and fills wherever the  Selection Tool

eraser is moved.
Erase Fills : Erases only the fill colors while lines are unaffected.

Erase Lines : It is used to erase the strokes only.
Erase Selected Fills : Helps in erasing a selected part of an object.
Erase Inside : Erasers the inner part of an object.

TEXT TOOL
This tool is used to type on the screen. It allows you to add text in your drawing g
animations.




¢ Tool. . . »
ot the Tex o, font, font size, etc. from the A ‘
56]6[1 Cc:ectl; > [eson |
1= ext loo
-C]rlgpe,- ty I ;ea of the Stage to get the cursor and f,;: La._” bRL %G 1 nem e
P n y J g L= % Scena |
ick © . e
o g the o te! . st the text box In the same way as || /™
[Yp ead d t ;;‘“' e : ‘ ' 5 "! i
; ;\Iﬂv ove the objects: l[ xpress Books
\
/lritersl"aml Y SO T ==
= ﬂ ah' 2

ot \j',’/zl A TimesHewRoman v 60 E] BB 7 £ =
Te
static , i
AV 0 E! At [Normai i-ali

T v] h‘mtrahas for readability 'j

90.0 L vl a o B (V] Auto kern
W :526 X = = : 43, .

i/”'}/ Usmg Text Tool
For Your "-go

Toselect the part of an object with Lasso Tool, select the object and press Ctrl+B (to break
agart the stroke and fill) and then drag the Lasso Tool around the part of the object you want

. to select.

JEATING A NEW FLASH DOCUMENT

' elect File > New. The New Document dialog box appears.
 select the Flash File (Action Script 3.0) option in the Type list.
) Click OK. A new Flash document will open.

) Select Modify > Document. The Document Properties dialog box appears. Change the
background color frame rate or stage size as per your choice.

'&-Dommt } e
e Templates
B " Description - e A
| pt3,0) 20 , -
ol Create a new Flash document (™.fla) in the Flash
| I r:: :: E"ﬂ-ﬂﬂsmp{ 20) Document wiindovy, The Fublish Settings will be set for
8 Fans, (Hobe) ActionScript 3.0, Use Flash documents to set up the media
| | s Fres:nmmn and structure for Flash movies and applications.
| 728 Fom 2ppiication
| |3 ianserpe Fie
.. 0%,
| |= =pt COanUmmu Eil
‘ Fesh J-mscnpt File P
l Ffu]m
_,=i".;. QuickiKey) I8
" You can double-chck the 2
S _ Eraser Tool to delete

e () () | everything on the Stage.

‘ Computer Science
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US-ING FRAME BY FRAME TECHNIQUE TO ANIMATE

Animations i Flash arc created with the help 7) For Your Iﬂgﬂ‘

of frames. Frames in Flash can be defined as e helos e
the little rectangular cells, which appear on Faucet Motl.lirf;::" 1eips l"sl’eﬂflupQ
t!le Timeline, Frames control the period of - !_9&]'_'](.3321'}5-—'*3. ----------- "
time of the movie. i IS
Keyframes are special types of frames where we define c!1ar1gc In the Objeg
animation like position, color shape etc. In Frame by Frame animation, we cregyg the iu
' every frame. Let’s add some art work for the document : !
Drawing a Star )

It is important to understand that whatever image is drawn in Flash consists of , Stroj
outline) and/or a fi]]. |
@ Select any color choice from the Stroke Color.

® Select red color from the Fill Color Picker. .

@) Click the drop-down arrow on the Rectangle Tool. A fly out menu will appear.

@ Select the PolyStar Tool and draw a star as explained in PolyStar Tool SUb"heading.

&

r M . =0y —
m Adobe Flagh €53 Profeesiona! - [Untitled-3+] !___Q_J[HE.]_E
Sile Edit Yiew Insen NMeaify Text Commands Control Debug Window Help

E] 10 13 20 25 30 25 40 45 50 53 60 6_5 70 ik il

"
o ® [ 1 120fps 005 4 | i | Gt 0 E’
&l

. —— —— 3 == I B: 0
o Oval Teel (O | ¥ 100% -
) Workspace™ 5, 4, N iohe: 100%

#FFO00D

L Rectangle Prmitve Tool (R)

< Oval Prmave Tool (O)
P L e e
YRR

s

aiphs: [100%: [+] @] Q|
7 I 15

e :
{| fUnhtIed-B 'Jv: g
: Empty lbrary

-
p =2 =l E
L o L
: L BEE

5|5

"

o

ELL

slsiElelsls{e

k]
Tool Settings Type
e w v
Phrperc! Saes &
Sroctee 0
' o7 ol ta ] (& [erer )
B (= Frepenes | Fitters | Parametess | : iz
B 1 v sl
Rectargly
= Teol SO m T Stroke hinting Scalg: I-:orni__vl Mitgr: 3 | Joln: 2,
. a _ .
f. : H . -\ rJ : _‘_l-—-"/

Drawing a Star

; I 98 | .
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nan‘-mnm(sithmu_uu,,m_l.l N T TR

an Otj.i(:}c‘t . . | Ee &1 vew (1) 1oty ten Commanst Comror Py r;-.'.-.“_‘_'“- T
; ﬂ,a‘i”g uick animation for the star that you ] e .
| ! 0S rﬂ"kzcross the stage. _ | “‘“ m_;';. ) .
Lgirc v e right of the keyfran']e dot.m Layer 1. | ;; | o .
r pﬂ"cli o 10 ttioﬂ will begin from this particular frame. o2 ]2 Lamsy
] ima : . ey ol R
! e 'f“k on the second frame in the Timeline. IER Ml e
¢ : ST |
j Now ol [sert > Timeline > Keyframe. This will f o
) (lick 0‘!’( eyframe in Frame 2 with a copy of the star { o
psert ahe gelection Tool, make a slight change in l’
 sing ¢ of the star towards right side of the |
" fhe position |
sfage- - . i i
Inserting a Keyframe in Frame 2

seonal « fUnEted 3]

—

e prote

Igaw“""“: et Mogty Test Commandt Cotie! Deod Window med
et AN

—
I Acote Flawn 53 Professony' - Ureted 17
Ele Et Mew et ook Test Commands Conret Qanug Yndew Hen

|
[ Yo
pe 2 .y Y
3 a0 2 YOO
1 X
s
! LT
! L |
o
ey | i W 1 20k el . Anaa
Al 1 oo - | . & 1ok o
\‘;0’ L Asaml VWorksps Za s Esoe
- a9
i SR
Fa ar
£y LE]
i @

Inserting a Keyframe in Frame 4 Using F6

Changing th-e color of Star in Frame 3
UClick on the third frame of the e e R TR
Timeline and press F6. — L,

-snﬁ

¥ Shift the star slightly to the right side .i :11 J Em“;m
of the stage. Change its color to sky 1>+ ot :
bhe by selecting it from the Fill |
I

: Color picker.
}C.ﬁCk on the fourth frame of the ||

limeline ang press F6 to insert a | o .
i eYﬁ'ame n it. .
) Sh | i -
it]s“ﬂ ltht: Star towards right and change i ?
0 Yellow,
'Epeal?ue ©0 insert keyframes by i Bt
Teach g the above steps till you | - :
] . the tentp frame. ;'j
V! T = - - !I
Cnﬂt;}“; the animation by ClleIIlg on n
et Wiovie Playing a Movie ,—5-9-—'
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A. Tick (v ) the right option.

. ) . s or stars. ety 5
1. i tool is used to draw polygons - @& polyStar (] (d) Line :
(a) Polygon [ ] (b) Star <k tll-i—neS? {

2. Which tool is used for creating stl‘allg‘l L"_J « Sval tool C ] (d) Pen tool {
o ke and fill color. \

(a) Line tool ] (b)Erasct art the stro
Bi cibusesbionss key combination is used to blEk E['(]:) el G 1 (d) Ctrl + |_
(] (b) Ctrl+V traight lines or smooth flg,,

(a) Ctrl + B .
" —— tool is used to draw precise paths as S

curves. 5 |

(a) Pencil (] (b) Brush (] ©@Pen b.g (d) None of these
Be  cuiiimensens key combination is used to group the selected 0OD]) . ——

(a) Ctrl + B (] (b) Ctrl+G (] (o) Crl+ \4 (] [

B. Fill in the blanks with the correct word.
Polystar Smart Sketch, developed by Jonathan Gay
1. Flash was originated with the application OF vvuerenmanennmnsenes

Brush Tool Panel Layers: Line Too|

f the other, each containing

Zi  sneseiii RS are like multiple film strips stacked on top O
different image that appears on the stage.
. . is the area where we create our drawings.
G is the area where graphics and elements are assembled in sequence.
IO~ tool is used to draw a star with five sides.

8. eoraennenn iR tool is used to fill an object with an exact color that we have used fi

another object.
C. State whether the following statements are true or false.
1. The shortcut key for Oval tool is ‘O’
2. The Rectangle tool is used to draw polygon and star figures.
3. To change the color style of lines, select stroke style option in the Property
Inspector.
4. The Fill Color tool is used to fill object with color.

5. The shortcut key to preview the animation is Ctrl + del.
D. Write the functions of the following tools briefly.

L. PONECTL BB |  cosssrserssmsensrumenessssesnsansansrosasssnsssasnnessnsns saassassnmssmasssresassnasssssessesosnsssssssonatsramrasassssymassasadosssssseiinrstsy
e g 1= B S S e
i - SR L S
4. Line e R T & i (i |
5. Oval o e PN S SRR

Book-6
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the following questions.
Aﬂgw 5 flash? What are the different components of Flash window?
\ wl

I ks the use of Timeline Panel in Flash wmdow'?
W

What is the difference between a Pencil tool and a Brush tool?
3,

Whatls the difference between Stroke and Fill Color?
A

5 ;J;at are the three modes of Pencil tool? Explain any one?

6. What are the options of the Eraser Modifier? Explain any two briefly.

Solve the following crossword using the hints given below :
(R0SS.J. i
3. Atool used to draw an oval or a circle (4) b2

-5 A tool used to draw rectangles and -
squares (9) o

6. Developer of Flash (5)

-]

M

[*]

Gives you access to all commands (4, 3) e[ 1]

Displays the name of open document ERCIEEE

(5,3) = e

m‘;:rﬁtoolthat removes strokes and fills (6) - l”l |TI

L light grey area around the stage (4, 4)
Contams different tools (4, 7)

* Amultimegia program (5)
A

g + 0ol that allows you to create special effects (5)
||; . :,

10

Use line, Oval and Recta ngle tools to draw a car.
S the PolyStar tool to draw 7 pointed stars.
e the Pencil tool to create the following figures.

\ Computer Sclence
B, ‘ Book-d
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'*H Lesson Extract

: COmDUferNe’rwork :

< Web Browser
What is Internet? « Search Engines
*  Brief History of Internet % Using Infernet
* Connecting to Internet + Searching Information
* Role of Computers in the Internet < E-mail
* World Wide web % Using E-mail
* Hyperlinks

We are familiar by now with the working of a computer and how to instruct it to dq Varig
tasks. But we have been dealing with a single computer. What about a situat
there are many co

: ion in Whic
mputers? In the previous class, you have learnt something aboyt Detwoy
and Internet. Let’s discuss these in detail.

COMPUTER NETWORK

A computer network is a group of computers that are linked either through physical wi,
Or a wireless system. These computers can communicate with each other. Frop ”
computer, you can access the information on nother, share
computers. e LR L

i share tiles and folders with ofy
A computer network helps in exchanging data YAHOO! | ' = fo @
and information and sharing software and Ria P —
hardware resources at a reduced cost in a| -~ | i i
reliable resources at a reduced cost in a n:“' it e N _1;:_\_‘3;;1
reliable manner. There are various types of | - ml&m& a‘ e &
computer networks like the LAN (Local Area o (oI o ) 093
Network) which is usually used in companies, i %mh o =
schools, universities, etc. It usually allows | = - __‘_.'_“'f_"':'f'"f_m_';
people who are within the premises to use it. :_“_m ﬁ“_oi mﬁg
Another type of network is the WAN (Wide Py e v
Area Network) which covers a large area. —— P o gy

P b P
10
b g A

WHAT IS INTERNET?

_ 7) For Uour Inﬂo
The name ‘Internet’ itself suggests its ——

meaning. It stands for International
Network of computers.

sthout
In a WAN, computers are connected Wwitho

1 Cables, whileinal AN thereis a wired network
A network is an interconnection between tw

o 3 13 Vﬂﬁ
0 or more computers. The internet is a ﬂell‘lﬂws
to networks” mputers spread across the world. Internet 2
us to share the information worldwide, with

Just a mouse click.
é 1 102| 1

“ Computer Science
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ot of Internet, the old saying “World is too small” has b
the i(;;obal Village”.
<TORY OF INTERNET

aﬁlﬁf H:thll man walked on the moon, the U.S. defence de

partment set an Advanced
; 19691 broject Agency (ARPA) for further research. They designed a network of four
cll

s s 10 oxchange and share tllleir data: This network was called ARPANET (Advanced
L‘Omputﬂ project Agency Networ ) L_atel, many Upwqrsmcs were allowed to join this
e lalld share the information. This was the beginning of ‘Networking of computers’
0" e bigger day by day- and gave birth to INTERNET—the technology which has
{fich & changed our life. Earlier, Internet was used by engineers, scientists and computer
"‘dicﬁ“);or research purpose. Gradually, the network was made accessible to private agencies
c.\'gef‘jnera] public. People started using it for sending messages and files between the

w e o The most interesting thing about Internet is that no single agency controls or

ampufer
;Tailftains the Internet.

India, internet services started on 15th August, 1995 through government owned company

(SNL Private internet service providers like Airtel, Reliance, Sify, Tata, etc. have also been
Jlowed to provide internet services.

cONNECTING TO INTERNET

nemet forms the world’s largest network of networks by connecting local, regional,
utional and international networks. There are various ways of connecting to the Internet.
The four main ways of connecting a computer to the Internet are :

. Adial-up connection using a telephone line or an Integrated Service Digital Network (ISDN)
L. ADigital Subscriber Line (DSL)

.. ACable TV Connection, and

i ASatellite Connection.

The first thing in order to get access to the Internet is to register with an Internet Service

P;mrider (ISP) and open an account with them. Depending on the type of service, you can
"Upusing a service called modem and your telephone line or you can use a cable modem.
Madband services are now commonly available. They allow high speeds and do not require
Y telephone Jine to be engaged while you are using the Internet. The service provider will
"*You detailed instructions on how to get connected to the Internet.

cen replaced by the
“fi[h
o

Thi

| 19 We Need to Connect to the Internet

| cm; St thing we need to connect to the Internet is a computer. Other than the
Mn;):ters We also need a few more things.

b [tton\, * A modem relays information between the computer and the Internet,
| ™ digital signals to analog and vice versa.

e Tnfo

e oiee
! Age “Oncept of Internet was first proposed by the Advanced Research Projects

:netwncy (ARPA) of the US government in 1969. In fact, the Internet began as
- 2MKcalled the ARPANET, .

e —— e e o e
T - il s s e

> | Computer Sclence



Telephone line : The information we send and receive over the Internet traye]g thrg,,
telephone cables. . . k. Inf :
ISDN line : ISDN stands for Integrated Services Digital Network. ndorma 100 tha tra\’e}
through the ISDN is two to four times faster than through any modem availab|q Man
telephone companies offer ISDN lines to connect to the Internet. _
Internet Service Provider (ISP) E The ;? For Your Ingfr
service provider can be any organization that )
gives us the facility for connecting to the

ice provider llows 1} - : PR
the v ot ot s oY AHOWS L analog signal into a digital signl g

ge. i the sending and receiving enqgg of 5

Web Browser : A Web browser is a software i  communication channel must have
|
i
|
|
|

® A modem changes a computer’y digi
signal into an analog signal and Al

used to access Internet. Microsoft Internet modem for data transmission tg oceyr.
Explorer, Mozilla Firebox, Netscape Navigator ® Companies like MTNL, BSNL, Ajrg
are some commonly used Web browsers. Tata, Reliance, etc. are ISPs, ’
ROLE OF COMPUTERS IN THE INTERNET -~~~ """~ "7~ 7 = = =m=m——eee
We know that the Internet connects over millions of
computers together. But, all the computers do not do the same
kind of task. Some computers act as storage and filing
shelves. These computers are called servers. Those computers
that get information from a server are called clients. et
In some cases, a single computer can act both as a client and

3 |
Client

as a server. For example, when we use a chat program to send

instant messages, our computer acts as a server as we send

messages and as a client as we receive them as is called peer- Coms — R,

to-peer communication or P2P. Client Saps Clent

There is another device that sends packets of information between the client and the server
This is called a router. Routers are responsible for finding the best path to send informatior

between the computers. A message we send using the Internet might pass several routers
before it reaches the recipient.

To internet

el S

Laptop with wireless adapter card

Desktop

ComputerScience
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(WORLD WIDE WEB)

The world Wld-e Web is a large computer network where by
4sing 2 browscl such as NL’lSCﬂl?C. Internet Explorer, you can
quf and get information. It consists of all (he public web sites
Conne"ted to the Internet worldwide, including the client
Jevices (such as computers and cell phones) that access web
conternts- The websites are identified by short, unique, global
identifiers called URLs (Uniform Resource Locator).

WWW contains millions of documents or ‘bunch of pages’ called we pages. Each page

contains text, graphics, video, audio and link to other web pages via hyperlink.
Hyperlinks are usually highlighted words. They are usually

underlined or highlighted in a different color to indicate that \" Ck h ere '

they are special words. When you point your mouse on a
hyperlink, 1t changes from an arrow to a hand.

when you click on a hyperlink, it magically transports you to
another Web page which may belong to a different site
altogether. Usually this Web page gives more detailed
information on the world that was clicked.

These hyperlinks are the most interesting part of the Internet. They connect different Web
pages and form the World Wide Web. The WWW is therefore nothing but an immense

~ collection of Web pages that are interconnected in complex ways.

| WEB BROWSER

A Web browser is a software application that allows
you to access Websites and view Web pages, once
" you are connected to the net. Microsoft Internet
. Explorer and Mozilla Firefox are the two most
commonly used Web browsers.

. At the top of the Web browser is an address line.
Here, you can type the address of the location on
the Internet that you want to visit. For example, to
access the National Geographic site, you can type
 http:/www.nationalgeographic.com.

~ The first part of the address http specifies the protocol which the computer will use to get
. information from this site. This protocol is called the Hyper Text Transfer Protocol. The
. Second part www stands for World Wide Web. This is followed by the name of the site.

3 f For Your Tufo

Computer protocol is a set of rules that enable computers to connect with
E jne another and to exchange and share resources.

e e o e e e e e e e e e ————— e
——
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< com’ is usually used for commercia| i

s the country. For cxample, ]]“P/iﬂdia_gsstq

The last part is the domain namc exiension
dia. v

country specific sites, the extension represent

the Website of the Government of India, where “in’ stands for In in;

Bookmarking a Web Page
You can bookmark pages that interest you, just o 2) For Uour I

pag @
as you would do in a book. Bookrnarklpg 7 URL means Uniform Resource |
helps you to look up those pages easily URL provides the location of the brg Caty
without having to search for them all over 1 —ooreomrmmmmmrmomemrmemee Wi Ser,
again.

The various steps to bookmark a web page are :

1. Click on you favourite menu on the menu bar and select the Add to Favoriteg ey

option.
2. In the dialog box that appears, give a name and location for the bookmark.
SEARCH ENGINES

What would you do if you wanted to visit a place whose exact address you don’t know9 Yo

would probably look for its location on a map. Similarly, on the .Intef'net, when yoy ,
looking for a site whose address you don’t know, you can search t."or it using a search engj,
A search engine is a software program that searches the World Wide Web for web pageg ,
contain the keywords or phrases that you have specified in the search. It then lists all the we
pages it has found containg the matching words. some of the common search engines g

Google, Yahoo and Rediff.

ias 4 \Glesl = . - :—:_-.. e e B B e W B
Gouogle =
- ;"“_“
< =
=
Google

USING INTERNET
We usually see captions like “visit us on www.intel.com”. Such type of text which star

from www and ends with .com, .in, or .org, etc. is called Web address or URL. To se¢
site on the Internet, you have to type its web-address in the address bar of the Intem
Explorer. E.g., If we enter the address, www.intel.com in the address bar, we will se€ th
official website of Intel. There we will see some coloured and underlined text. It is call
Link. On clicking a link, we move to another web page of the same (or some other) websit®

SEARCHING INFORMATION .
Internet is basically a vast resource of information. We can search and find informﬂﬂ_

about websites, images, news, questions and answers, videos, etc.

[ A
£ 2
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are exclusive websites for searching information ec.g. www.google.com or

o google.co.in from Google, www.bing.com from Microsofl, www.yahoo.com or
'yahoo.co.in from Yahoo.

ollow these steps to search any information. Let us say, we want to scarch the images of
: Deforestatlon on Internet.

open any search engine, say wwwigoogle.co.in. Click on the Images tab. Type
I ;Deforestatlon’ and click on Search button.

b L Pl
FIartestanon - fuv »

- ch S v mbe i

(‘D 3]8 e tinon

" ! cahitaah: (T ]

.

Google Search Eng;‘ng—www:gpog!e.com.fn

i o . : GIand v cgil
- 2. Alist of images will be displayed. Select the 1@ag§ you like.
| EmaL o't i
| EeMgiI'--"sﬁ'ands for Electronic Mail. It is a facility on Internet to compose, store, send and
. receiVe‘messages to any part of the world. The convenience, simplicity and affordability of
-~ sending mails on Internet has totally’changed the correspondence system.
E-mail is the fastest way of sending mails where the postal address details like name,
Address, City, State, Pin, Country, etc. have been replaced by the e-mail address. The E-mail

address is given in the format—infor@express.in. We can also attach photos, videos or
other important data along with our message.

The popular sites, which provide the facility to send or receive mails are : www.yahoo.co.in,
www.gmail.com, www.rediffmail.com, etc.
USING E-MAIL

To use e-mail facility on the Internet, first we have to create our personal e-mail account. We
ave to select a username (e-mail address) and provide a secret code (password) along with
our particulars like Name, Address, Date of Birth, Interest, Qualification, etc. You have
already learnt about all this in the previous class.
ome of the commonly used features are as follows :

| ‘ Computer Sclence ; Lrmr))
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Composing and Sending Mail
To write a mail to any onc, W¢
have to click on this option (or
any other similar option). It will
open a new window wherein W¢
type the e-mail address of the
receiver, subject of the mail and
the text in the Body. .

After composing an e-mail click
the Send button on the toolbar.

We can send the same mail to

many persons by typing their e- st el
mail addresses Separated by ' Laasa ma (3) Fer BUO by o I B ""‘"‘" ]
i e - -~ . i
o Composing and Sending E-mail
Attaching a File
ywhere in the

E-mail provides the facility to attach files for high speed delivery an
Attaching a file to an e-mail is an easy way to send important documents or files Which ¢,

be photographs, videos, music, letters, text, etc. To attach a file to an e-mail, follow the,

steps.
1. Click on Attach a file option under the ‘Subject field’.
2. Browse through your files and &% )
click the name of the file you * Stick :
W(,)UId ke 10 . Always remember, you cannot send executab),
3. Click on Open. files, or messages larger than 25 MB.

Replying and Forwarding E-mail
The Reply option is displayed when we open ) For Uour Iuﬂo«
any mail. It is used to reply a received When you visit any site, the first pag

e-mail. We can simply type in our reply and ¥ thatopensis called the o Page.

click on Send button. =~ LT PTR RO T Doerase
The Forward option is used when me want to send the same or any received mail to numb

of persons at the same time.

Adding a Signature to a Mail
A signature is a bit of personalize text (such as contact information or a favourite quote) th

is automatically inserted at the bottom of every mail you send. To create a signature follo

these steps :
I. Click the gear icon in the upper right, then select tsaton > @
Settings option. mgy
2. Enter your new signature text in the box at the *" e sa s, (oa R ST
bottom of the page next to the Signature option. s Ny it £
3. Click on Save Changes tab. Mot imgs it oot i v Uiy o, 18
Adding Signature

I 108|
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m you

WEE L]

out/SIQHOUt
| Elick this bglmon rosrzaifd }’Ouﬂha\c =an  sampleman2004@gmail. com ~
! ed rea mg o Ing the e-

ﬁnls This option brings you out

r e-mail account.
Sample Man

sampleman2004@gmail.com

Account Privacy

video Mg
of Gmai Add account Sign out
ur cantacts and mail into Gmail 2:37 pm

Signing Out

‘A Tick (v') the right option.

1

e . is a software program that searches the World Wide Web for web pages
that contam the keywords or phrases that you have specified in the search.

(a) Search Engine [_](b) Web Browser [_] (c) Website [ ] (d) E-mail ]
.is a software application that allows you to access Websites and view Web
pages once you are connected to the net.

(a) Web Browser ___| (b) Search Engine (]
(c) Hyperlink |_| (d) Website ]
is the most commonly used Web browser.
[a) Moznlla Firefox D (b) Google [ (c) Yahoo [ 1(d) Rediff ]
... helps you to look up Web pages easily without having to search for them.

(a) Search Engine L_| (b) Browser (]
(c) Book Marking |_| (d) Hyperlink L
. .. is inexpensive compared to phone calls and much faster than ordinary
mail.

(a) E-mail [ (b) Internet [ (c) Weblink [__](d) Web Browser [_|

109
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E.

Fill in the blanks with the correct word.

o1

W N

Modem  E-mail  Hyper Text Transfer Protocol

Home page ISP (Internet Service Provider)

The protocol which a Web browser uses to view information on Web Pages i -
........................ ed
In order to get access to the Internet, you need to register with an ................
You can send and receive letters on the Internet USINE wscssnivaiiinis

........................

converts digital signals to analog and vice versa.
The main page of a Website is called its ...

State whether the following statements are true or false.
1. Bill Gates is the founder of World Wide Web.

- Skype is one of the popular chat software.

2
3. Attachments can be sent through e-mails.

4,

5. Modem is a device that connects a computer with telephone line.
Expand the following terms.

|
2
3.
4,
o

Reliance is not a private Internet Service Provider.

Co00D

LAN
WAN
WWW
htp

e-mail

Match with the most appropriate option.

Colomn A Colomn B
1. E-mail (a) Electronic mail sent from one computer to another on
a network. ,

(b) Mail sent from one city to another through post office
(c) None of the above

2. Homepage (a) Page where home of a Website is designed
(b) First page of the Website
(c) Last page of the Website

3. Internet (a) Anetwork which connects two computers together
(b) The worldwide network of millions of computers
(c) None of the above

 rym——" |
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Di fl-e,-tm,ntiate between
f .. LAN and WAN
Browser and Search Engine

' E-mail
;, Chatand

qswer the following questions.

G 1 what is a computer network?

..............................
--------------------------------------------------
.................................................................................................

............................................................
--------------------------------------------------------------------------------------------------------------------

4. Name four Internet service providers.

=
. 5. Define the term www. Who is the founder of www?
6. What are the features of Electronic Mail? Name any two websites which provide the
E-mail facility.
% Use your favourite search engine to find the following Websites :
&

(a) An online dictionary.

(b) A Website of a newspaper.

(c) A Website of the History of India.

(d) The Website of the Government of India.

(e) A Website giving information about your city. |

‘__ Computer Science
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Circle ten Internet terms in the following grid- e
NzowWVVB.Y.X---»R-;&}%
dlolM|N{mPIY L[k|@HIC]
AP I NTERNE_T_._Y_Z.I.;
TWBLCJLHT}TP-,'-&;’I
Flelgle|AalK|]] H_J_E_;_‘J___f
HlvIie|R|S rRa|D|F -"__'___i__'_:g_j.E-.{
. A M O D E M| DJEJ,LJEJ
oo alwlT|AlnleFlE[ 1LY
sz nm K LNk
YDGE_-'A.__MJ:A”_'!L!LK__FL
X-W F R"._I;H_?T)?:HFQW Q| T|R.
" EviolslumMVvulc|N|S

i_
1

earch and download information and pictures on the

1. Visit the site—www.bing.com. S
an informative presentation by collecting information

topic—Global Warming. Create
from the net.

2. Write an e-mail to your fri
computer till now.

end describing your school and what you have learnt about

‘112] :
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'PROJECT WORK |
“\\, m———— &

A Draw a flowchartto checkifthe currentyearisa leap year.
B. Draw a flowchartto compute the area and perimeter ofasquare.

.C. Using mail-merge features of MS Word, create letters for inviting your friends on the
~ marriage ceremony of your sister.

___1'-;:,-}« i

Using MS Word create a poster on Traffic Satey Rules.

Create a PowerPoint presentation on the causes and effects of an earth quake. Add speaker
notes and animation effectsin your presentation.

Create a colorful presentation on the theme SAVE TIGER. Use your creativity and more slides
in this project.

G. Usevarioustoolstodrawa cartoonin FLASH and save the file.

H. Using Internet, collect information on ‘Art and Craft. Download important information in
MS World file and save it on your desktop. Namethe file as ‘Art and Craft’.

‘ Computer Sclence é
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9,
10.
11.

12.

13:
14.
15.
16.

17.
18.

¢ 1'114“ )

aIns necessary to Cal‘ly
Out

set of prog!

APPLICATION SOFTWARE : It is a
operations for a specific application.

ARITHMETIC LOGIC UNIT (ALU) :
operations within the computer.

ANIMATION : It refers to the special ef

[t performs al

fects added to the objects and text in 4

presentation. d
ARITHMETIC OPERATORS : It is @ S€t of operators used fo evaluate ,
mathematical expression.

BOOTING : It is a process that starts
on a computer system.

COMPILER : It is a language translator tha

program into machine language.
CONSTANT : It is a value that does not change during the execution of a program,
ter of the paragraph is bigger

DROP CAP : It is a feature in which the first charac
and dropped on the subsgquent lines of the paragraph. {

FOOTER : It is the text that appears at the bottoth |

the operating:system when the user typp

¢ translates high level language

margin of every page.

FRAME : It represents the content of the movie at a particular moment of time.

| the arithmetic and logiC] |
)

MACHINE LANGUAGE: Itis a language written using long strings of 0s and 1s for

computing.

OPERATING SYSTEM : It is a software that acts as an interface between the user

and the computer.
OPERATOR: It is a symbol used to evaluate an expression in a language.

PRIMARY MEMORY : It is the basic requirement of a computer.
PAGE MARGINS : Itis a blank space near the edges of the page

SYSTEM SOFTWARE : It is the software that .
. con i uter
operations. _ trols the internal comp

STRING : It is an alphanumeric value that is given within double quotes (" "

VARIABLE : It is a named memory At
y locat ¢ .
change during program execution. lon that contains a value which mé

v
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. SRIODIC TEST  Term ( 1
;_ije (N (Based on chapters 1 to 3)
: e MOrEs: cavmmminsny,,
Note : All questions a’W
. Tick(v)therightoption,
- 1. Informationon chequeisstored using
MIC
(a.l) . R .1 (b)OCR L1 (c)OMR L_i(d)LCD -
2. Linuxisa.............. based Operating system.
(a) Unix

L1 (b)Windows [] (c)DOS [ d)MAC 0S

3. Whichoftheseis Placedattheend ofa document?

(a) Header L1 (b)Footnote L1 (c)Endnote
B. Fillintheblankswith the correctwords,

L s Tepresents the first line hanging over the rest of the lines.
2. DOSstands for |

3. Thestorage device ofa computer system isreferred to..........ooonnn..
4. The

1 (d)Column

......................... is forlooking up synonyms for a particular word.
- C. State whether the following statements are true or false.

1. Theprogram inarunningstate is called afile.
2. Drop Cap feature is not ofany use in MS Word 2007.
3. Secondary memory is used to store data for long term use.
4. CPUisthebrain ofacomputer.
- D. Answer the following questions.
I 1. Whatisan Optical Mark Reader used for?
2. Why do you use page numbersinadocument?
- E. Identify the following. ’
1. k=8 i
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" . -.“" 4370
est Paper ’”'”’ “I”' II“'
(Based on chapters 110 %) 14—
Note : All questions are compulsory.
A. Tick(v)the rightoption.
| Intersectionofarowand columnis called '
(a) Table L] [h)Ccllhnrdel' L (c) el L (d) Tablegroup k..
2. PreviewResu]tsoplionispresentin,.......------.---grOUP'
[a]Previe\\fResu]t E (b) Preview D (C]RBSUH D(d) MessHges L:

3. Primary memoryisalso ) [ p—— -
- (d)auxiliary

(a)interna] ] [b]externa] L (c]storage L

4. Mailmergeisan important feature of
(a) MS Access ] ® MS Word ] (9 MS Excel D (d)MSWindow |_

onofcurrentslide, we clickonthe
hing L (d) anythign ||

o

To preview the transiti
(a) slide show button |__ (b) play button L (c)not

B. Fillinthe blanks with the correctwords.

1. Thewayoneslide follows the other on the screenis called s :

7 Datasourceisalso called the s ;

3. Bydefault, header is printed . inches from the top of the page.

4. Softwarerelates TR L1] P— ,

. Statewhetherthe following statementsare trueor false.

| Data source contains the text that we wish to send to all the recipients.

2. Shadingcanbe applied using Borders and Shading dialog box. -
3. Thereis onlyonetypeofoperatingsystem. -
4, Dataaresi1in? computerin theform of words and letters. =

D. Matchthefollowing.

1. Alt+Ctrl+2 (a) Toinsertendote

2. Ctrl+Alt+D (b) Toapplyheading?2

3. Ctrl+D (c) Torumaslideshow

4. F5 (d) Tomakeaduplicate ofthe currentslide

Computer Sclence =
Book-b
o
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Time : . — N
- T P T T I T T TIT] | I — N

Note : All questions are compulsory.

A. Tick(v)therightoption.
? . tion.
1. e Statement can be used in controlllngC0|umn loca

(a) Print [] (b)Tab [] (c)PrintTab [ () armat..... [~
2. Symbolofinput/ outputboxina flowchartis

ey [ o] L1@A L@ L
3. Thedefaultextension of MS PowerPointfileis

(a) .pptx [] (b).doc O

(c) xls [1 (d)noneofthese ]

B. Fillinthe blanks with the correctwords.
1. Numeric constants contain only ...
2. Highlevellanguages are translated into the machine language by ........cccceeeuee. .
3. AWatermarkisa.............. image that appears behind the text of a document.
By o is conditional decision making statement.

C. State whetherthe following statements are true or false.

1. Avariable name can be amaximum of 50 characterslong.

2. Therearethreetypes oftranslators.

3. Anothername foraddressbookis Mail merge. e _ Hﬂl
4. The Windows operating system was developed by Microsoft. o j
D. Answerthefollowing questions.
1. Whatare compilerand interpreter?
2. Whydoyouuse page numbersinadocument?
E. Name thestatement/command.
1. Thecommandisusedas counterloop.
2. Thestatementisused to give values to avariable,
3. Thecommandis used to putacommentline inyour program.
4

The statementis used to display the output on the screen.

H Computer Science
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Marks : ...

e —_—
. ne:
= yestions are compulsory.

vote’ Allq
rick (/) the rightoption.

........
pare

isadevice used for creating high quality graphics.

(a) Plotter ) (b)Printer . (c)MICR | (d)OMR |
7. Mailmerge isanimportantfeature of
b (a) MS Access (] (b)yMSword (] (c) MSExcel ] (d) MSwindow -
3. Tohidethe welcome dialogbox, press.................key.
(a) Ctrl ] (b)Esc ] (©Alt ) () Alt+F
4 e IS the most commonly used web browser.
(@) MozillaFirefox ] (b)Google (] () Yahoo (] (d) Rediff ]
B. Fillinthe blanks with the correctwords.

Anoperating systemisa

2. Theway oneslide follows the other on the screen is called .....cceervruruneee ;
3. Thefull form of QBASICIS w.unmeeeeoon
4

The protocol which a web browser uses to view information on web pages is called

Match the following.

1. CPU (a) isanapplicationsoftware for creating presentation
2. PowerPoint (b) isused fordecision makingstep

3. Aflowchart (c) isthebrainofthe computer

4. Adiamong (d) isagraphical representation of steps for solution to

‘ aproblem
1tate Whether the following statements are true or false.

astwo main parts: hardware and software.

anbe formatted with borders in MS word 2007.
3 APFOgram isaset ofinstructions.

Acompyter h
Only Pages ¢

A The Shortcutkey topreview the animation is Ctrl +del.
. Nswer the following questions.
2' z\vrthh device is used for readingbarcode?

hyisitimportant to properly shut down your computer?




WhatisaData Source?

Whatare compiler and interpreter?

- ¥ 1 i 7
Whatis the use of Timeline Panel is Flash window

oG w

Whatis a computer network?
F.  Write the full forms of the following abbreviations.
1. MICR : 7 OCR 1 e,
3. RAM 4. BIXT  §  asciisnismssiiesnesmmomsonnsesiisindd
5. ROM T TSR 04 23 D N SRR
G. CircletenInternettermsin the following grid.
oW zlowwws|v[xRls]
(HIO/M/N|MIP U|lL|K|Q|H|C |
A F’I NT Ei R!N E'FI Yi—?r_ ...........................................................
Tws L El T LRI TITIRPI Al i
HIVIEIRISIRIQID|F[I[RIE] i
I AMODEWM I D G| L H| |
F’ZCS;ZNEM;KLDNK ...........................................................
v|p|e|E| -] '"M_!_R—;' lLlLl kP
x|wlFIr[P[¥[x|olwia[ TR e = s
ale|v]o|e|ulm{v[u[c|n[s] & = = eaaEA

H. Labelthefollowingpicture.

{
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Computer Concepts is a diligent effort to provide the best and
comprehensive understanding of the subject.

4 Lesson Extract outlines the objectives of the chapter.

4+ Chapter Content starts with an engaging introduction. The textis
supported with pictures and relevant screenshots.

For your Info (Information) gives extra and useful information for
memory reinforcement.

Time to Drill interspersed within each chapter to check the
alertness of tha students.

- . = .activitiesthatcan bedoneinthe lab.

~ =ample questions to assess students’
heconcepts learnt,

A series that wiil prove to be a treasure house for overall digital
- development. .
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